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J.D. Edwards Software 

J.D. Edwards software supports manufacturing, financials, distribution/logistics, and human 
resource operations for multisite and multinational organizations. An organization�s business 
needs determine what application suites are installed in its enterprise system. Complex 
business situations might require several application suites to achieve a comprehensive 
solution. J.D. Edwards combines those applications with an integrated toolset and tailors 
them to meet the needs of each business. 

Application suites are created from combinations of systems. For example, the Financial 
Suite includes system 03B (Accounts Receivable), system 04 (Accounts Payable), system 09 
(General Accounting), system 12 (Fixed Assets), and others. Systems, in turn, consist of 
executable functions, forms, reports, database tables, and other components that are 
designed for specific business needs. 

You use J.D. Edwards Translation Tools to translate each component of each system in 
J.D. Edwards software. 

Before You Begin 

Before you begin translating J.D. Edwards software, you should familiarize yourself with the 
following guides:  

! Foundation Guide 

! Development Tools Guide 

! Development Guidelines for Application Design Guide 
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J.D. Edwards Translation Tools 

J.D. Edwards Translation Tools are tools that translate J.D. Edwards software products from 
a source language, such as English, into multiple target languages quickly and efficiently.  

J.D. Edwards Translation Tools provide the following features: 

Contextual References As you translate the interface, you can view items in context. 

Consistency Features You can view previously translated terms to ensure a 
consistent translation. 

Automated Translations When you choose an item to translate, the J.D. Edwards 
Translation Tools searches the database for that item. If it 
finds a match, Translation Tools automatically displays the 
translation. 

 

In most translation applications, items appear in context. For example, all items within a task 
appear together, and the items of a form are shown the way that they appear in the software 
so that you can view the context while translating. 

During the translation cycle for a new release of J.D. Edwards software, the items to be 
translated are made available to the translators through the Delta Process. The Delta 
Process extracts the translatable items from the software, stores these items in a J.D. 
Edwards-supported database, and assigns status codes to the items. 

When extracting the translatable items from the software, the Delta Process compares the 
new release of J.D. Edwards software with the previous release to locate the changes, and 
assigns a status of 20 (Untranslated) to new or changed items. 

As you translate using J.D. Edwards Translation Tools, you update items on a J.D. Edwards-
supported database every time that you click OK. 

Caution  

The system has no lock capability, and two or more translators can access and translate the 
same item at the same time. The last translation saved is the translation reflected in the 
system. If two or more translators are working on the same system, they should divide their 
work to ensure that they do not overwrite each other�s work.  

 

J.D. Edwards software contains a variety of application suites, or verticals, that relate to 
different departments within an organization, such as distribution, manufacturing, and human 
resources. Multiple systems reside within each vertical. 

You might be assigned to translate the human resources and financial verticals. As you 
translate different systems, you will notice that, due to the subject of the applications, terms 
used in one system are not used in others. 

Although you can translate the software items in any order, J.D. Edwards recommends that 
you translate the software interface in the following order: 

1. Glossary entries (using a translation memory such as TRADOS) 
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2. Data dictionary items 

3. Processing options 

4. Forms 

5. Reports 

6. Menus 

7. Tasks 

8. User defined codes 

9. Resource files 

10. Miscellaneous items 

Consistency Features 

J.D. Edwards Translation Tools provide features that enable you to translate consistently. 
Because a single term can have multiple meanings, you should translate source terms 
consistently throughout a system. You use consistency features to ensure that previously 
translated terms are consistent with current translations.  

Suggestions 

When you choose a previously translated item, J.D. Edwards Translation Tools enters the 
selected translations in the Source and Target translation fields. You can set up J.D. Edwards 
Translation Tools to suggest the previous translation or to always suggest the data dictionary 
description, even when the item has an override.  

The suggestions for previous translations come from your source language database. 
J.D. Edwards Translation Tools allows you to add new suggestions as well as edit existing 
ones. 

Space Constraints 

A fixed amount of space is available for each translatable item. Because translated 
information requires varying lengths of text, you might have to abbreviate your translations. 
When you have exceeded the number of bytes allotted for an item, the system generates one 
of the following warnings:  

• Abbreviate the translation 

• Use another term 

• Check the preview (Many forms have maximum and minimum buttons that allow the 
user to control the length of the controls) 
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Translating Controls 

The amount of space available for the translation is measured either in characters or pixels, 
depending on the type of control chosen. The following table shows the 9 types of controls 
available and whether the control uses a pixel-or character-based measurement: 

Control Space Measurement 
Push Button Pixel-based 

Check Box Pixel-based 

Radio Button Pixel-based 

Static Text Pixel-based 

Group Box Pixel-based 

Hyper Button Character-based 

Bitmap Character-based 

Text Variable Character-based 

Control Pixel-based 

 

Search and Replace 

Each J.D. Edwards translation application except FASTR, Favorites, and Menus, includes a 
search and replace feature. Each tool has slightly different search and replace functionality 
and, depending on the type of text, requires separate search criteria. You access the search 
and replace feature from each tool separately. For example, you cannot perform a search of 
UDC items and replace them using the F79750: Forms Design Aid (FDA) tool.  

Spell Check 

You can use the Microsoft Word spell check feature with most J.D. Edwards Translation 
Tools. Before using spell check in J.D. Edwards Translation Tools, you must choose the 
appropriate language options in Microsoft Word. You can only use spell check for single-byte 
languages. You should use the spell check feature before you save translations.  

Default Codes Used in J.D. Edwards Translation Tools 

Within J.D. Edwards Translation Tools, all translatable items must have a status code. Status 
codes indicate:  

• The status of each translatable item 

• Whether the item is ready to be packaged in the software 

• The location of the item in the translation process  
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As you translate, you enter the appropriate status codes to ensure that the source terms do 
not appear in the software. During the software mastering process, only translated items with 
the following statuses appear in the software: 

• Complete (status = 11) 

• FDA/RDA DD Default (status = 15) 

• Review (status = 25) 

If a translated item has any other status codes assigned, the source term for that translated 
item appears in the software. 

In addition to the status codes, two other types of codes further define the translatable item:  

• Reason 

• Skip 

The delta process updates the Reason code to indicate the type of change (for example, a 
text or size change). You update the Skip code to indicate why you did not translate the item 
(for example, the item is test data or a translation is not needed for your language). If you 
assign a Skip code to an item, the Source text appears in the software.  

Translatable J.D. Edwards Items 

The translatable items in J.D. Edwards software include the following:  

• Data dictionary items 

• Glossary entries 

• Processing options 

• Forms 

• Reports 

• Tasks 

• User defined codes 

• Resource files 

• Miscellaneous items 

You can use J.D. Edwards Translation Tools to translate all items. However, you can use a 
translation memory, such as TRADOS, to translate glossary items for processing options and 
data items. 

Data Dictionary Items 

The data dictionary stores the text items used for row and column headings, alpha 
descriptions, and glossaries (F1 or field-level helps) for reuse. When translating these text 
items, you should view the associated glossary entry, if available, to understand the context 
of the data dictionary item and to ensure that you are using consistent translations.  
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Glossary Entries 

Glossary entries describe data dictionary items and their use in the software. You can view 
glossaries from multiple applications by using J.D. Edwards Translation Tools. Being able to 
view the glossaries from multiple applications allows you to see their context while you 
translate. You translate each entry using a translation memory, such as TRADOS. 

Because glossaries can contain hundreds of lines of information, they are among the most 
time-consuming components to translate. 

Processing Options  

You can use processing options to customize most J.D. Edwards applications according to 
your needs. Processing options allow you to supply parameters to control how a program 
functions. For example, processing options allow you to:  

• Specify defaults for certain form displays 

• Control the format in which information appears on reports 

• Change how a form displays information 

You translate all of the tabs and the processing option text on the processing option forms. 

Forms 

When you access an interactive application, a form appears. Each form contains a title and a 
variety of controls, tabs, grid items, and hyper controls, all of which must be translated.  

Reports 

Similar to forms, reports contain grid items, controls, and titles that must be translated. 
Column items and section controls correspond to data dictionary items. 

Tasks 

J.D. Edwards software contains task menus that allow access to subtasks, applications, and 
reports. As you translate tasks, all task items and submenus appear together so that you can 
view them in context.  

Some tasks must be translated with a different tool than that which you use to translate the 
task items.  

User Defined Codes 

User defined codes (UDCs) are codes and descriptions in the software that provide you with 
an easy way to choose a value from a list. UDCs are stored in tables within J.D. Edwards 
software, and you access them from these tables.  

Each user defined code contains a description of the option as well as a code for that option. 
You translate only the descriptions; the codes remain the same in every language.  



 7

Resource Files 

Resource files (for example, files with extensions such as .rc, .dll, .exe) are applications 
generated by third-party tools (for example, Java and C++) that appear throughout 
J.D. Edwards software. These items are not J.D. Edwards items, but they must be translated 
into the target language or users will see source text. These files include error messages, 
toolbar menus, and the legal disclaimer.  

Miscellaneous Items 

A few items in the J.D. Edwards software interface cannot be included in any of the previous 
categories, and J.D. Edwards Translation Tools does not recognize them. These 
miscellaneous items are contained in specific tables within the J.D. Edwards software and 
include user defined time periods and the names of the months. You translate miscellaneous 
items by using the FASTR and Favorites applications.  

 

Accessing the J.D. Edwards Translation Tools  

You access all the J.D. Edwards translation tools through the Translation Applications menu 
(GH791). On the Translation Applications menu, all translation applications appear in a tree. 
When you access any of the translation tools for the first time, the system displays default 
information. When you access the tools; you see the information that you last entered when 
you last exited the program (for example, product code, status, and so on.). No translation 
items appear until you search for them.  

► To access any translation tools 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator. 

• The Senior Translations version of the program automatically updates the 
translation item status to 11 (Complete) from a status of 20 (Untranslated) or 25 
(Edit/Review). 

• The Junior Translations version of the program automatically updates the 
translation item status to 25 (Edit/Review) from a status of 20 (Untranslated). If 
the item is already at a status 25, the status does not change automatically. 

1. To begin translating, click Translation Tools and then choose one of the translation 
applications (for example, F7920 : Resource Text Translations (RTT)).  

2. Click OK. 
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Note 
Subsequent navigations in the Translation Tools documentation assume that you are 
a senior translator. 

 

Reviewing Audit Information for a Delta Process 

You can review the audit information for a Delta Process to ensure that the Delta Process 
has been run over the items that you want to translate. The Delta Process determines what 
development changes have occurred in J.D. Edwards translation tables over a specific 
period. The process compares the J.D. Edwards translation tables, as they are at the time 
that you run the process, with the Production or Mastered versions, as they were when you 
last ran the process.  

► To review audit information for a Delta Process 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
choose Translation Tools: 

1. On the View tab, click a translation tool, and then click the Audit tab. 

2. Review the following fields: 

• Object Name                              

• Status Description                       

• Delta Total Records                      

• Delta Change Records                     

• Delta Begin Date                         

• Delta End Date                           

• Delta Begin Time                         

• Delta End Time                           

• Delta User                               

Understanding Information Common to All Tabs 

Many of the tabs on the Fix/Inspect forms in the J.D. Edwards Translation Tools contain the 
same information. You should be familiar with the following information before using the J.D. 
Edwards Translation Tools. 

The examples in this chapter are taken from different translation tools. However, you can find 
the information defined in all translation tools. 
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View Tab 

The View tab contains display and option information for individual items, files, and objects.  

Audit Tab 

The Audit tab contains audit trail information for an individual translation item or for an object. 

Status Totals Information 

The status totals are the total number of translation items that were transferred when the last 
Delta Process was run.  

Translator or Translation Audit Information 

The translator or translation audit information identifies who last translated an item, when it was 
translated, and so on. 

Audit Trail Information 

The audit trail information provides you detailed information about who accessed an item. 

Glossary Tab 

The Glossary tab contains the glossary information for items that have glossaries. Each 
Glossary tab contains header information�for example, the data item name and a 
description.  

The Glossary tabs contain two panes. The top pane is the source pane or untranslated text. 
The bottom pane is the target pane or translated text. You cannot always change the text in 
these panes. The Translating the Data Dictionary section of this guide explains all you need 
to know about the Glossary tab and translating data dictionary items. 

The Source and Target Panes 

The source and target panes are located in the common area. The common area is located in 
the lower section of almost all of the forms of the J.D. Edwards Translation Tools. When you 
click an item in the detail area, the current source and target text appears in the fields in the 
common area. 

Pane Explanation 
Source Displays the term or text in source language. The application 

also uses this field to store variable-length terms or text for use 
by J.D. Edwards Translation Tools. 

Target Displays the term or text in target or translation language. The 
application also uses this field to store variable-length terms or 
text for use by J.D. Edwards Translation Tools. 
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All common areas in the J.D. Edwards Translation Tools forms contain Status, Change Type, 
and Skip Reason information for the individual item that you choose to translate. 

J.D. Edwards Translation Tools Options 

You can customize the appearance and performance of the J.D. Edwards Translation Tools 
to suit your translation style and to allow the system to assist you in translation.  

Display 

You access the translation applications from a tree. You can customize the tree to either limit 
or expand your view of the data items that you want to translate. Click the following options to 
define your view:  

• Source 

• Target 

• Both 

Field Explanation 
Source Display only the source text. 

Target Display only the target text. 

E  Display both the source and target text. 

 

 

Move by Status 

The Move by Status feature allows you to specify which translation items appear when you 
finish translating the current item. The Move by Status feature moves to the next item at the 
status that you specified on the Find/Browse (Work With . . .) form.  

For example, if you are working only on translation items at status 20 (Untranslated), with the 
Move by Status feature turned on, the system displays only those items at status 20. You can 
specify any status in the translation process.  

► To turn on Move by Status 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
choose any of the following translations tools: 

F79750 : Forms Design Aid (FDA) 

F79760 : Report Design Aid (RDA) 

F98306 : Processing Options (PO) 

1. On the Find/Browse form (Work With . . .), complete the following field and click Find: 

• Status                                   
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The status that you specify here is the status at which the system displays the 
records when you turn on Move by Status. 

2. Choose an item from the detail area and click Select. 

3. In the translation application that you are using, click the following option to turn it on: 

• Move by Status 

4. Enter your translation in the Target field and click OK. 

The translation tool saves the translation and then displays the next item with the 
same status. 

Moving from Item to Item 

J.D. Edwards Translation Tools allow you to move from item to item without having to exit the 
translation tool in which you are working. You have two options that allow you to move from 
item to item: 

• Move Previous and Move Next 

• Previous and Next 

Using the Move Previous or Move Next Features 

The Move Previous and Move Next option allows you to view the items in the detail area of 
the previous �Work With� form. You can use both of these features to move from item to item 
in the detail area of the �Work With� form on which you searched for items. 

You can use the Move Previous or Move Next features only in the following J.D. Edwards 
Translation Tools:  

• F79750 : Forms Design Aid (FDA) 

• F79760 : Report Design Aid (RDA) 

• F98306 : Processing Options (PO) 

Using the Previous and Next Features 

You use the Previous and Next features for much the same reason that you use the Move 
Previous or Move Next features. The Previous and Next features, however, are different in 
the following ways: 

• They function independently of the Move by Status.  

• They move to the next or previous item in the detail area of the previous �Work With� 
form regardless of whether you turn on Move by Status. 

While you can use the Previous and Next features in all of the J.D. Edwards Translation 
Tools, you might find that you do not need them in the tools that have the Move Previous or 
Move Next features. 
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Checking the Spelling of Your Translations 

J.D. Edwards Translation Tools uses the spell check feature within Microsoft Word. You must 
set up the options in Word for your target language. If you do not set them up, the spell check 
feature will not work properly. 

Warning  

Ensure that you close Microsoft Word before running the spell check feature in J.D. Edwards 
Translation Tools. J.D. Edwards launches the spell check feature regardless of whether 
Microsoft Word is open. If Microsoft Word is open when you run the spell check, it might shut 
down without saving any work in progress.  

 

 

Before You Begin 
! Close all sessions of Microsoft Word before you run spell check in J.D. Edwards 

Translation Tools. If Word is open when you run spell check, Word might shut down 
without saving any work that you have open. 

Manual Spell Check 

Before you advance to the next item to be translated, you can check the spelling of the item. 
The Spelling tab highlights any misspelled words.  

► To manually check the spelling 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then 
choose any translation tool. 

1. Locate and choose any translation item other than a glossary item. 

2. Choose Spell Check from the Form menu. 

Misspelled words appear in red. 

3. Correct any spelling errors. 

4. Click one of the following options: 

• OK 

The J.D. Edwards Translation Tool saves the translation, updates the status, and 
displays the next item in the Source data field. 

• Save 

The J.D. Edwards Translation Tool saves the translation and updates the status. 
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Auto Spell Check 

You can specify that J.D. Edwards Translation Tools automatically spell check your 
translations as you enter them. To do so, turn on the Auto Spell Check option. The following 
task demonstrates how to turn on the Auto Spell Check option in the F7920 : Resource Text 
Translations tool. You can use the Auto Spell Check feature in almost any tool. 

► To auto spell check 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translation (RTT). 

1. On Work With Resource Text Translation, complete the following fields and then click 
Find: 

• Selected File Name                       

• Status                                   

• Language                                 

2. Click an item in the tree menu and then click Select. 

Alternatively, you can double-click a translation item in the tree menu. 

3. On the Resource Text Translation form, turn on the Auto Spell Check option. 

Auto Hot Key 

A hot key is a key sequence that automatically launches a shortcut when pressed (for 
example, CTRL + C is a hot key for the command Copy). The Auto Hot Key feature allows 
you to automatically copy the source hot key into the target translation. Alternatively, you can 
manually copy the hot key from the source field into the target field if the source and target 
hot keys are the same. 

Changing Item Status 

Each time that you revise a translation item and click OK, the system automatically updates 
the item status. The next status that the system chooses in the translation process depends 
on which version of the tool you are using. The following table describes the versions and the 
next status to which the system moves a translation item when you click OK. 

If you are using: The system automatically updates the 
translation item to: 

Senior Translations 11 (Complete) from a status of 20 (Untranslated) or 
25 (Edit/Review) 

Junior Translations 25 (Edit/Review) from a status of 20 (Untranslated) 

If the item is already at status 25, the status does 
not change. 



 14

You can manually change the status of the translation process. For example, if you are using 
a Senior Translations version and you are unsure if the item is translated accurately, you can 
change the item to 25 (Edit/Review) to indicate that it should be reviewed. 

► To change item status 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, complete the following fields and then click 
Find: 

• Selected File Name 

• Status 

The default value in the Status field comes from a processing option for the 
version that you are using. 

• Language                                 

The default value in the Language field comes from your J.D. Edwards user 
profile. 

2. Choose an item and click Select. 

3. Translate the item and click OK. 

The F7920 : Resource Text Translations (RTT) tool saves the translation with the appropriate 
status code based on the version (junior or senior) that you are using. 

See Also 
! Additional Information: Status Codes in the Translation Tools Guide for a description 

of the J.D. Edwards Translation Tools status codes 

Entering Translations Manually 

When you begin translating items, the system provides suggestions from previous 
translations. These suggestions come from your source language database. The system 
populates your target fields with these suggestions. You can enter translations manually, 
such as when the item is new and you do not agree with the suggestion or when the 
suggestion is a fuzzy match that would require a great deal of editing. (A fuzzy match is a 
source text that only partially matches the target text.) 

You can enter translations manually on any Fix/Inspect form in any of the J.D. Edwards 
Translation Tools. 

► To enter a translation manually 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then 
choose F7920 : Resource Text Translation.  

1. On Work With Resource Text Translation, complete the following fields and then click 
Find., 
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• Selected File Name                       

• Status                                   

• L  

2. Choose an item in the tree menu and then click Select 

Alternatively, you can double-click a translation item in the tree menu. 

The Resource Text Translation form displays the source text.  

3. In the Target field, enter the translated text. 

4. Click OK.  

J.D. Edwards Translation Tools saves the translation and updates the status. 

5. Click Next. 

J.D. Edwards Translation Tools displays the next item in the list. 

Copying Translations 

Many times the source text is a sufficient explanation for the target item or you cannot 
translate the target item. You can use the following features to copy information from the 
source text fields into the translation target fields.  

Copy Source 

 

Copies the text for all source fields to the translation target fields.  

Copy Alpha 

 

Copies the translation for the Alpha description into the row and column translation 
fields. (Use this feature for data dictionary translation only.) 

Copy Row 

 

Copies the translation for the row description into the translation field for the column 
description. (Use this feature for data dictionary and translation tools only.) 

Copy Previous 

 

Copies the translation for the last saved translation into all translation fields. 

Copy Tab 

 

Copies the translation from the Short Name field to the Long Name field. (Use this 
feature for processing options translation only.) 

 

Note 

For data dictionary items, always translate the alpha description first so that the copy 
functions are available for the row and column translations. 
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Copying the Source Item 

If the source item has no translation in the target language, you can copy the source item into 
the Target field.  

You should copy source text only to help you format your translations; you should never save 
the source text as your translation. If the source text does not require translation, assign the 
item status 30 Other (Skip Reason). Status 30 skips the translation for that item. If you do not 
assign status 30 to the item, the system displays the source text.  

► To copy the source item 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then 
choose F7920 : Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, complete the following fields and click 
Find: 

• Selected File Name                       

• Status                                   

• Language                                 

2. Choose an item and click Select. 

The Resource Text Translation form displays the source item in the Source field. 

3. Choose Copy Source from the Form menu. 

The source item appears in the Target field. 

4. Translate the item. 

5. Click OK.  

Using Suggestions 

J.D. Edwards Translation Tools allow consistency and save time by allowing you to use items 
that have already been translated. When J.D. Edwards Translation Tools find a previously 
translated item, it automatically completes the Target field so you can use the suggestion and 
immediately go to the next untranslated item.  

Alternatively, you can search for translated items manually. When using suggestions, you 
should consider whether you want to retrieve suggestions manually or let the system retrieve 
them automatically, and whether you want to save your own translations as suggestions. 

The suggestions data field, located in the lower right of the translation tool forms, contains the 
following entries: 

• None 

No appropriate translations exist for this source term. 

• Exists (Loaded) 
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The data field contains a lightning bolt icon, which indicates that a suggested 
translation is available for this source term. When you click the icon, the Suggestion -
Search & Select form appears. You then can search for the most appropriate 
translation for the source term.  

• More Exists  

The data field contains a lightning bolt icon, which indicates that more than one 
suggested translation is available for this source term. When you click the icon, the 
Suggestion -Search & Select form appears. You then can search for the most 
appropriate translation for the source term.  

• DD Default 

The data field contains a light bulb icon, which indicates that appropriate translations 
are available for this source term. When you click the icon, the Data Dictionary 
Translation form appears.  

• Not checked 

Based on the status of the term, the system did not search the database for any 
suggested translations. 

You can use the Suggestions on any Fix/Inspect (Work With. . .) form in any of the 
J.D. Edwards Translation Tools except the following:  

• F83100: FASTR Date Title 

• F83100: FASTR Column Headings 

• F91100: Favorites Relationships and Properties 

You also can access it directly From the Translation Tools menu (GH791) by choosing either 
Senior Translations or Junior Translations, depending on your role, and then choosing 
Suggestions from the Form menu.  

Manually Searching for Suggestions 

J.D. Edwards Translation Tools allow you to manually search for and use previously 
translated items. You manually research translations when you are not satisfied with the 
default suggestions. 

► To manually search for suggestions 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, complete the following fields and then click 
Find: 

• Selected File Name                       

• Language                                 

2. Choose an item in the detail area and then click Select. 

Alternatively, you can double-click a translation item in the detail area. 
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3. On the View tab of Resource Text Translation, ensure that the Suggestions option is 
turned on. 

4. In the Length field, enter the number of beginning characters you want J.D. Edwards 
Translation Tools to search when finding matches. 

For example, if you enter 5, J.D. Edwards Translation Tools uses the first five 
characters of source text to search for and retrieve matching translated items. 

• If J.D. Edwards Translation Tools finds only one term and the Target field is 
blank, it automatically loads the text into the Target field. If the existing translation 
is accurate for your item, continue to step 7. The Suggestion Search & Select 
icon also appears here. 

• If J.D. Edwards Translation Tools finds more than one term, it displays the 
Suggestion Search Select icon with the text More Exists. 

5. Choose Suggestions from the Form menu.  

Note 
The compressed description in the Source Search Text data field contains the search 
text without spaces, slashes, dashes, commas, or other special characters. The 
compressed description is the field used in the Data Dictionary Name Search. 

 

6. To search for translations, on Suggestion - Search & Select, enter search criteria in 
the appropriate fields on the form and click Find. 

7. Choose the translation you want to use from the detail area, and click Select. 

The Resource Text Translation form appears, displaying the translation that you 
chose from the Target data field. 

8. Click OK.  

The J.D. Edwards Translation Tool saves the translation and updates the status. 

9. Click Next to move to the next translation item. 

Automatically Searching for Suggestions 

If you are translating items with a status 20 (Untranslated), you can use J.D. Edwards 
Translation Tools to automatically search for and use previously translated items. 
J.D. Edwards Translation Tools alerts you if it finds more than one option for the item you are 
translating. You can make your search general or more specific by selecting the number of 
characters you want to search on in the Source term. For example, you can specify your 
search by directing the software to retrieve only those items that match the first 40 characters 
of the Source term. Alternatively, you can make your search more general by directing the 
software to retrieve only those terms that match fewer characters.  
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► To automatically search for suggestions 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT).  

1. On Work With Resource Text Translation, complete the following fields and then click 
Find: 

• Selected File Name                       

• Status                                   

• Language                                 

2. Click an item in the detail area and then click Select. 

Alternatively, you can double-click a translation item in the detail area. 

3. Ensure that the Suggestions option is turned on. 

4. In the Length field, enter the number of beginning characters you want J.D. Edwards 
Translation Tools to search when finding matches. 

For example, if you enter 5, J.D. Edwards Translation Tools uses the first five 
characters of source text to search for matching translated items. 

• If J.D. Edwards Translation Tools finds only one term and the Target field is 
blank, it automatically loads the text into the Target field. If the existing translation 
is accurate for your item, continue to step 7. The Suggestion Search & Select 
icon also appears here. 

• If J.D. Edwards Translation Tools finds more than one term, it displays the 
Suggestion Search & Select icon with the text More Exists. 

Note 
The compressed description in the Source Search Text data field contains the 
search text without spaces, slashes, dashes, commas, or other special 
characters. The compressed description is the field used in the Data Dictionary 
Name Search. 

 

5. Click the icon or choose Suggestions from the Form menu if you are not satisfied with 
the suggestion that was loaded. 

6. On Suggestion - Search & Select, choose the translation you want to use. 

7. Click Select. 

The Resource Text Translation Text form appears, displaying the text that you chose 
from the Translation field.  

8. Click OK.  

The J.D. Edwards Translation Tool saves the translation and updates the status. 

9. Click Next to move to the next translation item. 
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Adding Translations as Suggestions 

You can add your translations as a suggestion for you or other translators to use later. You 
have two options when adding translations; each option adds the suggestion differently. 
Perform one of the following when you add a translation as a suggestion:  

You The system  
Click OK Automatically saves the translation to the code page as well as the 

Translations Suggestions (F7910) table as a suggestion if the following 
conditions exist: 

• The Suggestion option is turned on. 
• The suggestion does not already exist. 

Choose Add 
Suggestion from the 
form menu 

Saves the translation to the Translations Suggestions (F7910) table.  

 

You can use suggestions on any Fix/Inspect (Work With. . .) form in most of the J.D. Edwards 
Translation Tools. 

► To add a translation as a suggestion 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, complete the following fields and then click 
Find: 

• Selected File Name                       

• Status                                   

• Language                                 

2. Click an item in the detail area and then click Select. 

Alternatively, you can double-click a translation item in the detail area. 

3. On the View tab of the Resource Text Translation form, ensure that the Suggestions 
option is turned on. 

4. In the Target field, enter the translation for the current item and perform one of the 
following actions: 

• Click OK 

• From the Form menu, choose Add Suggestion. 



 21

Updating or Deleting Suggestions 

You can update or delete a suggestion using the Translation Suggestion Search and Select 
(P7910S) program. You can access this application from any of the J.D. Edwards Translation 
Tools. The J.D. Edwards Translation tools themselves do not update or delete suggestions.  

After you have created a suggestion for one item of source text, you cannot add an additional 
suggestion for that exact source text. If the record exists, the system does not add another. If 
you need to update that suggestion, you have the following options:  

Update You might want to update the suggestion if:  

• The text has changed slightly. 
• The space requirements have changed (you have either more or less space for the 

translation). 
Delete You might want to delete the suggestion if: 

• The source text is obsolete. 
• The suggestion was added by mistake. 
• It is easier to delete the suggestion and enter another than to update the current one. 

 

► To update or delete suggestions 

Use one of the following navigations: 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator. On J.D. 
Edwards Translation Tools choose a translation tool.  

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator. Choose 
Suggestions from the Form menu, and then complete steps 5 through 8. You might want 
to do this if you need to go directly to Suggestions to perform maintenance on the 
suggestions.  

The following steps use the Resource Text Translations tool as an example. 

1. On Work With Resource Text Translation, complete the following fields and then click 
Find: 

• Selected File Name                       

• Status                                   

• Language                                 

2. Click an item in the detail area and then click Select. 

Alternatively, you can double-click a translation item in the detail area. 

3. On Resource Text Translation, turn on the Suggestions option, and then choose 
Suggestions from the form menu. 

4. On Suggestion - Search & Select, locate the record that you want to update or 
delete.  
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5. Click the record in the detail area, and then choose Update Suggestions from the 
Form menu. 

If no suggestions appear in the detail area, you must add one.  

6. On Work With Translation Suggestions, complete the following fields (if needed), and 
then click Find:  

• Source Search Text 

• L anguage 

• Product Code 

7. Click a record in the detail area and then click OK. 

8. If you want to delete the suggestion, click Delete and then go to step 9. 

9. If you want to update the suggestion, click Select and then go to step 8. 

10. Update or delete your suggestion in the Target field, and then click OK. 

11. Click Cancel. 

Using Source and Target Preview  

The J.D. Edwards Translation Tools offer many features to help you further refine the data, 
structure, and physical appearance of your translations. The following features help you 
refine your translations:  

Source Preview This feature allows you to view source objects as they appear in the software. Use 
the source preview to review software objects in the source language for content 
and format as you make translation choices. 

Target Preview This feature allows you to view target objects as they will appear translated in the 
software. Use the target preview to review your software objects in your target 
language for content and format as you make translation choices. 

The following J.D. Edwards Translation Tools have Source Preview and Target Preview: 

• F79750 : Forms Design Aid (FDA) 

• F79760 : Report Design Aid (RDA)  

• F9203 : Data Dictionary (DD) Alpha 

• F98306 : Processing Options (PO) 

► To use source or target preview 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then 
choose any translation tool with source or target preview.  

1. Choose an item in the detail area. 

2. From the Form menu, choose one of the following:  

• Source Preview 

• Target Preview 
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Using Keyboard Shortcuts 

Using keyboard shortcuts saves you valuable time when translating. You can use the 
following keyboard shortcuts to move between tabs and items on the J.D. Edwards 
Translation Tools forms. 

Ctrl+Tab Moves between tabs from left to right. 

Ctrl+Shift+Tab Moves between tabs from right to left. 

Alt+X Moves to the next item on a Find/Browse (Work With. . .) form. 

Alt+V Moves to the previous item on a Find/Browse (Work With. . .) form. 

Alt+O or Enter OK. 

Ctrl+End Moves to the last selection in the detail area. 

 

The Search and Replace Translation Tool 

The Search and Replace workspace consists of a form with three or four of the following 
tabs: General, Application, Search Text, and Find/Replace. The number of tabs depends on 
which translation tool you are using. 

General Tab 

When you access the Search and Replace tool from a J.D. Edwards Translation application�s 
Find/Browse (Work With. . .) form, the form that appears consists of the upper and lower 
common areas with the detail area in between. The detail area of the General tab is the only 
area that is different for every application. 

The General tab allows you to further define your search criteria. For example, if you know 
the Date Translated � From and the Date Translated � Through, you can limit your search to 
that period of translation. 

Application Tab 

When you access the Search and Replace tool from an application�s Find/Browse (Work 
With. . .) form, the form that appears consists of several tabs. The Application Tab is different 
for each of the four applications. Each Application tab consists of data fields that you use to 
define your search and replace.  

Application Tab on Forms Design Aid (FDA) 

The Application tab on Forms Design Aid (FDA) allows you to further define your search 
criteria. For example, if you know the Form Name and the Data Item, you can limit your 
search to that form and the data item that appears on it. 
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Application Tab on Report Design Aid (RDA) 

The Application tab on Report Design Aid (RDA) allows you to further define your search 
criteria. For example, if you know the Object Name you can limit your search for the text on 
only that object.  

Application Tab on Processing Options (PO) 

The Application tab on Processing Options (PO) allows you to further define your search 
criteria. For example, you can limit your search according to PO Text Type.  

Application Tab on Solution Explorer Tasks 

The Application tab on Solution Explorer Tasks allows you to further define your search 
criteria. For example, if you know the Task ID, you can limit your search for the text on that 
object only.  

Search Text Tab 

When you access the Search and Replace tool from an application�s Find/Browse (Work 
With. . .) form, the form that appears consists of several tabs. All Search Text tabs are the 
same for each application. 

Find and Replace Tab 

When you access the Search and Replace tool from an application�s Find/Browse (Work 
With. . .) form, the form that appears consists of several tabs. The Find and Replace feature 
allows you to find specific search strings of translated text for the application that you are in 
and replace them with a new or updated translation. You can replace each instance 
individually or you can replace all instances. The Find and Replace tab is the same for each 
application.  

When you choose the Replace Translation option, the system searches for the selected 
source translation that matches the term in the detail area that you want to replace. When the 
system finds a match, the source translation appears in the Source field, and your proposed 
replacement translation appears in the Target field. You have the following choices when you 
replace text:  

When you choose:  The system:  
Replace Replaces only current text and remains on that text 

Replace Next Replaces only current text and finds the next text match 

Replace All Replaces all text in the detail area with matching criteria and returns 
to the top of the grid 

 



 25

Using the Search and Replace Tool 

The Search and Replace tool exists in all of the tools except for the following: 

• F83100 : FASTR Date Title 

• F83110 : FASTR Column Headings 

• F91100 : Favorites Relationships and Properties 

When you replace a translation and save it, J.D. Edwards Translation Tools allow you to 
proceed to the next item on your list. Continue replacing translated items until you have 
completed your list for all of the applications. 

Before You Begin 
! Review Additional Information: Jargon and Overrides in the Translation Tools Guide. 

Using the Search and Replace Tool 

Within J.D. Edwards software, you work with source language data terminology and translate 
this terminology into a variety of target languages. The Search and Replace tool helps you 
locate a specific term in the source or target language and review all of the associated 
translation variations for a record. The Search and Replace tool is specific to each translation 
application, and therefore allows the user to search and update only existing files relevant to 
that application.  

You can use wildcard characters to expand your search or if you are not sure of the spelling 
of your search term. Several types of wildcards exist. The J.D. Edwards Translation Tools 
use an asterisk (*). 

Asterisks (*) substitute a string of characters of any length at the beginning of the string, the 
end of the string, or both. Asterisks (*) specify 0 (zero) or more alphanumeric characters. You 
can use wildcards to obtain special results. The following table illustrates wildcard use in the 
Search and Replace tool (where string equals any alphanumeric string). 

Search 
String 

Description Search Text 
Example 

Source Results Target Results 

string* Begin Wild Code* Code Page Página de código 

*string End Wild *Code Purge Code Código de depuración 

*string* Total Wild *Code* Managerial 
Analysis Code 1 

Cód de análisis gerencial 1 

string Exact Code Code Código 

Once you define your search criteria, you can find and replace the following types of text 
strings:  

• Text strings with other text strings only 

• Text strings with text strings containing spaces 

• Text strings with spaces only  

• Text strings with nulls 
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The following table illustrates a sample search. One carat (^) equals one space. 

Search 
Text 
Example 

Replace text 
strings with. 
. . 

You enter the 
following in the 
Find field. . .  

You enter the 
following in the 
Replace field. . . 

Target Results 

*Code* Other text 
strings 

*Código* CódXigo CódXigo 

*Code* Text strings 
containing 
spaces 

Código* *C^^^ódigo* C^^^ódigo 

Code* One blank Código* *^Código* ^Código 

Code* More than 
one blank 

Código* *Cód^^^^igo* Cód^^^^igo 

Code* Null Código* * (blank) 

 

The most effective way to perform the search and replace is to complete the search criteria 
on the tabs in the following order:  

1. General 

2. Search Text 

3. Find/Replace 

► To define your general search criteria 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, complete any of the following fields and 
click Find:  

• Selected File Name 

• Status 

• Language                                 

2. From the Form menu, choose Search / Replace. 

The system updates the header of the Search and Replace form with some of the 
information that you entered in the header area of the Work With Resource Text 
Translation form, such as Selected File Name and Language. However, the system 
does not update the Status field with the value from the Status field on the Work With 
Resource Text Translation form. Instead, it supplies the default value of 11 
(Complete) because you normally want to search for completed items only.  

Depending on the application from which you access the Search and Replace 
feature, different search criteria appear. For example, if you access the Search and 
Replace feature from F0004 : User Defined Code (UDC) Types and the fields in the 
header contain values, the search criteria are the product code and the language. 

3. On the General tab, complete any of the search fields, and then click Find.  



 27

Note 
You can search only for the following statuses when using the Search and Replace 
feature:  

• 11 (Complete) 

• 20 (Untranslated) 

• 25 (Edit/Review) 

 
After you define your general search criteria and review the results in the detail area, 
you can either define your search text or find and replace target items. 

► To define your search text 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, complete any of the following fields and 
click Find:  

• Selected File Name 

• Status 

• Language                                 

2. From the Form menu, choose Search / Replace. 

3. On Search and Replace, click the Search Text tab.  

The system updates the detail area of the Search and Replace form with the 
information from the General tab. 

4. To further define your search, complete any of the search fields, and then click Find:  

• Source 

• Target 

• Primary Search 

• Source 

An option that specifies whether the system searches for a match on the 
source description first and then the target description. If the system finds a 
match, it then checks the target description for a match based on the search 
criteria chosen in the Secondary Search. 

• Target 

An option that specifies whether the system searches for a match on the 
target description first and then the source description. If the system finds a 
match, it then checks the source description for a match based on the search 
criteria chosen in the Secondary Search. 

• Secondary Search 

• Case Sensitive 

An option that specifies whether the search is case sensitive. If you turn this 
option on, it applies to the Primary Search that you did not choose. For 
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example, if Source is chosen in Primary Search, the case sensitivity option 
applies to Target. 

• Equal To 

An option that specifies whether the system returns items to the detail area 
for which the Source and Target items match. If you turn this option on, the 
system returns only those items for which both the Source and the Target 
items contain the string you entered in the Source or Target field. If you do 
not turn this option on, the system returns only items for which the Source 
matches but Target does not. 

After you define your search text and review the results in the detail area, you can 
find and replace target items. 

► To find and replace target items 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT).  

1. On Work With Resource Text Translation, complete any of the following fields and 
click Find:  

• Selected File Name 

• Status 

• Language                                 

2. From the Form menu, choose Search / Replace. 

3. On Search / Replace, click the Find/Replace tab and complete the following fields: 

• Find 

• Replace with 

4. From the Form menu, choose one of the following:  

• Next 

The system chooses the next item in the detail area. 

• Replace 

The system replaces the current item in the detail area. 

• Replace / Next 

The system replaces the current item and then chooses the next item in the 
detail area. 

• Replace All 

The system replaces all items in the detail area. 

• Previous 

The system chooses the previous item in the detail area. 

• Top 

The system chooses the uppermost item in the detail area. 
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Approving Target Items 

You can use the Search and Replace Tool to approve target items; for example, target items 
changed by the Multiple Release Exact Match program (P7903). 

► To approve target items 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, choose Search / Replace from the Form 
menu without completing any fields. 

The system updates the header of the Search and Replace form with some of the 
information that you entered in the header area of the Work With Resource Text 
Translation form, such as Selected File Name and Language. However, the system 
does not update the Status field with the value from the Status field on the Work With 
Resource Text Translation form. Instead, it supplies the default value of 11 
(Complete) because you normally want to search for completed items only.  

Depending on the application from which you access the Search and Replace 
feature, different search criteria appear. For example, if you access the Search and 
Replace feature from F0004: User Defined Code (UDC) Types and the fields in the 
header contain values, the search criteria are the product code and the language. 

2. On the General tab, complete the following fields and click Find: 

• Status 

Filter Status = 36:Exact Match 

• Language                                 

• Last Translator                          

Last Translator = XTRANS (eXact TRANSlation) 

3. Choose a record in the detail area. 

4. From the Form menu, choose Review Approved to update items to 11 (Complete). 

Before You Begin 
! Set the processing options for version ZJDE0003 (Quality Assurance) of the 

Translation Tools program to 36:Exact Match. 

Saving Translations 

When you save a translation, J.D. Edwards Translation Tools save the translation to the 
Code Page Environment and perform the following actions:  

•  If you click OK, the J.D. Edwards Translation Tools save the translation, updates the 
status code to 11 (Complete) in the compare environment, and automatically displays 
the next available item in the following J.D. Edwards Translation Tools:  

• F79750 : Forms Design Aid (FDA)  
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• F79760 : Report Design Aid (RDA)  

• F98306 : Processing Options (PO) 

For all other J.D. Edwards Translation Tools, you use the Next or Previous buttons to 
display the next available item for translation. 

• If you click Save on the above applications, the current item is saved: however, 
the next available item does not automatically display.  

The status that you apply to a translated item depends on the status of the item when you 
opened it. If the item�s status was 20 (Untranslated), each tool updates the status to the 
default value specified in the processing options for that tool, which is either 11 (Complete) or 
25 (Edit/Review).  

Caution 

You must save your work after each translation. The system does not prompt you to save the 
translation before choosing another item, so be sure to save your work. 
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Resource Text Translation 

 

 

Resource files (for example, files with extensions such as .rc, .dll, .exe) are the applications 
generated by third-party tools (C++ and Java). They appear throughout J.D. Edwards 
products and include error messages, toolbar menus, and the legal disclaimer. Resource file 
items can be a single word or a short paragraph. To ensure consistency, one translator 
should translate all resource files for one language using the Resource Text Translation 
program (P79201). Resource files occur throughout J.D. Edwards software; they are grouped 
by file rather than product code.  

You translate all resource items using the F79201 : Resource Text Translations (RTT) tool. In 
addition to translating items, you can retrieve and use existing translations, check the spelling 
of your text, change the status of an item, save translated items, search for and replace 
target text, and so on.  

You have three options when translating resource files. You can enter a translation manually, 
copy the source text that has already been translated manually, or use suggestions.  

Many items in the resource files include a hot key. Hot keys can be localized to your specific 
language, but standards should be followed for consistency. 

Because resource files are not grouped by product code, you generally translate them in the 
order that they appear in the tool (RTT). Resource text, however, is grouped by the resource 
file and parent identifier.  

Note 

Resource files have names such as jdeuser.dll, and the items are contained in these files. 
The parent identifier is sometimes just a number (for example, 128), and does not necessarily 
tell you what kind of item you are translating. Often, you can deduce that you are working 
with a dialog, but nothing as specific as the Calendar or Calculator. 

 

Translating Service Pack Resources 

Resource Text Translation (RTT) comes from DLLs and Java files that are part of 
SourceSafe and the Service Pack trees. This information is not part of standard Pristine Data 
Sources or tables. The translating service pack resources process includes an extract and 
update for the resources in the DLLs and Java files. 

The Resource Life Cycle is associated with Service Packs (for example, SP14, SP15, and so 
on) and not a major release (for example, Xe or B9). 

► To translate service pack resources 

You run several different processes when you translate service packs. Your programs could 
be in a different location (Rtt.exe, for example). The following steps give you high-level 
guidance so that you do not miss any of the steps in the process.  
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Your Mastering group should perform some of these steps, and your Translation group 
should perform others. The following steps indicate which group should perform which task.  

Order is critical for resource processing. The following steps must be completed in order.  

1. The Mastering group extracts the RTT files into a source Delta environment using the 
Rtt.exe. 

2. The Mastering group runs the Delta Process using the Translation Delta Process 
program (R79800) for each compare environment for each tier. 

3. The Mastering group runs the Check Delete Status program (R79802) to update 
orphaned records in the status stable. The process runs all languages simultaneously 
for each compare environment. 

4. Either the Translation group or the Mastering group rebuilds the keys by language 
using either the Delta Purge and Rebuild Process program (R79801) or the Resource 
Text Translation program (P79201). 

Note 
Any translator can perform this step. Use the Rebuild Key option from the Form menu 
of the Resource Text Translation program (P79201). 

 

5. The Translation group translates the source items using the Resource Text 
Translation program (P79201). Translate each language. 

6. The Mastering group runs the Delta Purge and Rebuild Process program (R79801) to 
purge the records set to a status of 99 (Purge from System). Run this process once 
for each language. 

7. The Mastering group builds the package (.dll and .jar files) using the Rtt.exe. 
Run this process once for each language. 

8. The Translation group checks the package (.dll and .jar files) using Visual C++, 
OneWorld Standalone, and language install on a Web Server for Java and HTML. 
Check the package for each language. 

Note 

Everything done by language needs to use the appropriate setup for the language and code 
pages. 
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Translating Resource Text 

Resource Text Translation (RTT) finds and displays items by matching the search criteria you 
enter in the fields or on the Query by Example (QBE) line. The information you enter in these 
fields remains until you change it. The files that appear contain the items that you will 
translate.  

► To translate resource text 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then F7920 
: Resource Text Translations (RTT). 

1. On Work With Resource Text Translation, complete the following fields and click 
Find:  

• Selected File Name 

• Status 

• Language                                 

Notes  
The F7920 : Resource Text Translations (RTT) tool retrieves the resource items that 
match the search criteria and displays them in the detail area. 

Any language that you search on that is not specified in your user profile is read-only. 

If you leave any of the fields blank, the system uses the default value of * (asterisk), 
which equals a search for all items. 

 

2. On Work With Resource Text Translation, choose a record in the detail area and then 
click Select. 

3. On Resource Text Translation, click the item in the Menu Tree that you want to 
review or translate. 

4. Enter your translation in the Target window, and then click OK to save it. 

You must enter a translation. The system does not save blank records.  
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Translating the Data Dictionary  

Data dictionary items include check boxes, radio buttons, text fields, grid items, and help text 
that appear throughout J.D. Edwards software. The data dictionary stores the descriptions for 
these items. Each data dictionary item contains at least one of the following components:  

• Alias - an alpha code given to a data dictionary item 

• Alpha description - the title that appears in the help text in the software when you 
press F1 

• Row description - the text that describes controls 

• Column description � the text that describes grid items 

• Glossary - the full description text in paragraph form when you press F1 

The Data Dictionary Translation Process 

Translating a data dictionary item is an iterative six-step process, as described below:  

1. Choose the data dictionary item you want to translate. 

2. Review both the data item components for context and the suggestions for 
appropriateness. 

3. Enter the translation manually or copy existing translations. 

4. Check the spelling. 

5. Review space constraints. 

6. Save the translation and start the process over again.  

The J.D. Edwards data dictionary translation tools use many of the same processes 
repeatedly.  

Before You Begin 
! Review Additional Information: Jargon and Overrides in the Translation Tools Guide 

to understand how to translate overridden and jargon items. 

The Relationship Between Data Dictionary Items and the Forms Design Aid 
(FDA) Translation Tool 

The data dictionary translations you enter are the translations for their corresponding forms. 
Therefore, when you access a form in the Forms Design Aid (FDA) Translation Tool 
(P797501), the data dictionary translation appears as the field description unless the item has 
an override. The status for the form items in the Forms Design Aid (FDA) Translation Tool 
remains at a status of 20 (Untranslated) until you save the translation. When you save the 
translation, the item moves to a status of 15 (FDA/RDA DD Default).  

When you edit a data dictionary translation, FDA items that are not overridden by a language 
are set to a status of 25 (Edit (Review)). You can view the list of language-overridden and 
non-overridden forms in the English Non-Overridden Forms box. When you access the 
affected forms in the Forms Design Aid (FDA) Translation Tool, the edited translation 
appears in the Translation field. 
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Using *SAME  

When translating an alpha description that has jargon applied, two fields appear for both the 
Source and Target columns: Alpha - Base and Alpha Description. If the translation of the 
base description is correct for the alpha description, you can reuse the base description by 
entering *SAME in the Translation field.  

Data Dictionary Tools  

You use three data dictionary language translation tools to translate data dictionary items:  

• F00165 (GT92002): Data Dictionary (DD) Glossaries 

• F9202 : Data Dictionary (DD) Row / Column 

• F9203 : Data Dictionary (DD) Alpha 

You access all of these tools through the Translation Tools menu (GH791). 

Displaying Data Dictionary Items  

When you access any of the data dictionary translation tools, the data items for the system 
and status you specified appear. You can select an item by double-clicking it or by choosing 
the item in the detail area and clicking Select.  

If you are looking for a specific item, you can use the Find button to search by alias. You also 
can search for a specific item from a different system. To display all items in another system, 
specify a new system in the Product Code field. You can view and edit translation items in a 
product code not specified in your user profile.  

The Find/Browse (Work With . . .) form allows you to search for data dictionary items that 
require translation or review. You can search for data items by product code, language, 
status, or all three. When you select an item on one of these forms, you access the Data 
Dictionary Translations form. 

Data Dictionary Space Constraints 

A fixed amount of space is available for most data dictionary items. Alpha and row 
descriptions are allotted 40 characters, and column descriptions are allotted 20 characters for 
the top translation field and 20 characters for the bottom translation field.  

Although your translation might fit within the space allotted in the data dictionary translation 
tool, it might not fit in the space allotted in the Forms Design Aid (FDA) Translation Tool. In 
other words, not all forms allow 40 characters for controls. 

A data dictionary item can be used on many forms, and those forms might all allow different 
amounts of space. The data dictionary translation tool finds the form that allows the least 
amount of space, and displays the amount so that you can enter a translation that will fit in all 
forms. If you exceed the space available, a warning message appears.  
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Note 

To view a non-overridden form or a form with a translation override, click the form name in 
the English Non-Overridden Forms box. 

 

 

Translating Alpha, Row, and Column Descriptions 

The Data Dictionary Language Translation program (P799201) treats alpha descriptions as 
individual items with their own status codes. When you translate, you must choose to work 
with either alpha, or row and column descriptions. Because most alpha descriptions have 
related row and column descriptions, it is best to translate alpha descriptions first. 

Row and column descriptions make up one item. One status code applies to both 
descriptions. 

See Also 
! J.D. Edwards Translation Tools in the Translation Tools Guide 

! Space Constraints in the Translation Tools Guide 

Translating Glossary Entries in J.D. Edwards Software 

The glossary is the help text that you see when you press F1. As you translate items, review 
the glossary entry to understand the context in which the data dictionary item is used. If you 
notice a mistake in the translated glossary entry, you can edit it on the Glossary tab.  

Note 

J.D. Edwards Translation Tools do not have a translation memory. 

 

 

► To translate glossary entries in J.D. Edwards software 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then 
F00165 (GT92002) : Data Dictionary (DD) Glossaries. 

1. On the Work With Glossary Data Dictionary Translation form, complete the following 
fields and click Find:  

• Product Code 

• Glossary 

• Status                                   

• Skip from 

• Skip to 

• Language                                 
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2. Choose a data item in the detail area and then click Select. 

3. On Data Dictionary Translation, click the Glossary tab. 

4. Enter your translation in the lower media object window. 

5. Click OK to save your changes. 

The data item moves to the next workflow status. When you click OK, Translation 
Tools saves the changes and updates the status. The new glossary item will appear 
on the Translation tab the next time the Delta Process is run. 

Filtering Glossaries 

You can filter the glossaries to select exactly the ones that you want to export. You might 
want to filter glossaries to control the size of the output file. 

► To filter glossaries 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F00165 : (GT92002) Data Dictionary (DD) Glossaries. 

1. On Work With Glossary Data Dictionary Translation, click the Filter tab, complete the 
following fields, and then click Find: 

• Product Code 

• Glossary Group 

• Status 

• Skip From 

• Skip To 

• Language                                 

Your user profile saves the values that you enter. These values reappear the next 
time that you log in.If you are using TRADOS, you should limit the size of your export 
to 0.5 MB. TRADOS can only receive files less than 0.5 MB in size. If your file is 
larger than 0.5 MB, TRADOS displays an error. You will have to experiment to 
determine how many records equal 0.5 MB because glossary records vary in size. 

2. Click the XML tab. 

You now can export glossaries from J.D. Edwards software. 
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Exporting Glossaries from J.D. Edwards Software 

After you complete the steps to filter glossaries, you must export the glossary data from 
J.D. Edwards software. 

On export, an XML file is saved to the file path specified in the File Path (Folder) field. The file 
name is created using the primary filters located on the Filter tab. The system uses the 
following primary filters to build the export file naming convention. The File Path (Folder) field 
is limited to 30 characters. 

Language_ TranslationStatus_SystemCode_GlossaryGroup_ 
DataItemFrom_DataItemTo.XML  

The following example illustrates a typical file name: 

S_20_01_D_A_L.XML 

Where: 

S = Spanish 

_20 = Untranslated 

_01 = Address Book 

_D = Glossary Group 

_A = Data Items from A  

_L = Data Items to L 

Data items can be used in a range, such as A to L, or be specific, such as AN8 or 
LNGP. 

In the file name on the XML tab, the wildcards (*) that you might have used on the Filter tab 
are substituted for a plus sign (+). A plus sign should work across all ASCII code pages. 
Additionally, the system uses a default path naming convention in the file name field. J.D. 
Edwards recommends that you do not change this naming convention. 

► To export glossaries from J.D. Edwards software 

On Work With Glossary Data Dictionary Translation, click the XML tab. 

1. Ensure that a file path is specified as a root directory in the following field: 

• File Path (Folder) 

A literal folder must be set up to handle the export/import (C:\ is the default). You 
must have the same file path set up in your root directory as is specified here. 
The File Path (Folder) field is limited to 30 characters. 

2. Ensure that you have a file name in the following field. 

• File Name 

3. Click one of the following options: 

• Source 
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Source text is exported. 

• Target 

Target text is exported. 

• Remove Hard Return 

Important 
Choosing the Remove Hard Return option will remove all hard returns from the 
glossary records. The import process does not reinsert the hard returns. 

 

4. After you have entered the appropriate filters, specified the File Path (Folder) field, 
and determined the text option, from the Form menu, choose Export. 

An XML file has been created. 

5. You can now use your translation memory to translate glossaries. 

Translating Glossaries in a Translation Memory 

J.D. Edwards Translation Tools provide the ability to filter glossary information, including the 
alpha description, and create an XML file.  

An example of a translation memory tool is TRADOS. The TRADOS Tag Editor allows you to 
use translation memory, including the TRADOS Translators Workbench. After translation is 
complete, the Translation Memory Editor saves translated data in an XML file. J.D. Edwards 
Translation Tools then import the XML file into the correct environment and code page in 
J.D. Edwards software and include preview functionality, which allows translators to validate 
the data. 

► To translate glossaries in TRADOS 

1. Complete the steps to export glossaries: 

2. From the Form exit, choose TM Editor. 

3. Either the TagEditor for TRADOS will open or the TM Editor listed in the processing 
options will open. 

4. Edit the glossaries using the translation memory functions. 

5. Choose File Save as Target and replace the XML file. 

You now can import glossaries into J.D. Edwards software. 

Importing Glossaries into J.D. Edwards Software 

You import the glossaries into J.D. Edwards Software similar to the way that you exported 
them.  
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► To import glossaries into J.D. Edwards software 

After you complete the steps to translate glossaries, you must import the glossary data into 
J.D. Edwards software. 

1. Ensure that you have saved the data in the XML file. 

J.D. Edwards software uses the primary filters to build the import file naming 
convention. Ensure that the file name is exactly the same as when you exported it. 

2. From the Form menu, choose Import. 

3. The status records are updated to Translation Memory at status 35. 

You now can validate the glossaries. 

Validating Glossaries in J.D. Edwards Software 

You can validate your glossaries after you import them back into J.D. Edwards Software.  

► To validate glossaries in J.D. Edwards software 

After you complete the steps to import glossaries, you can validate the glossary data in 
J.D. Edwards software. 

1. On Work With Glossary Data Dictionary Translation, choose a record in the detail 
area and then click Select. 

2. On Data Dictionary Translation, click the Glossary tab and then verify that the 
glossary text was imported correctly. 

3. From the Form menu, choose Target Preview and then verify the format of the F1 
help. 

4. Validate all glossaries that you imported again. 

Editing Data Dictionary Alpha or Row, and Column Entries 

You can edit Alpha and Row, and Column Entries dynamically. Editing them dynamically 
allows you greater consistency when translating the data dictionary. 

► To edit data dictionary alpha or row, and column entries 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
choose either F9202 : Data Dictionary (DD) Row / Column or F9203 : Data Dictionary 
(DD) Alpha. 

1. On the Fix/Inspect (Work With . . .) form, locate the records that you want to 
translate.  

2. Choose an item in the detail area and then click Select. 

3. On Data Dictionary Translation, click the Translation tab. 

4. Complete the following target fields as necessary: 

• Alpha Description                        

Enter an alpha description translation. 
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• Row Description                          

Enter a row description translation. 

• Column Title                             

Enter a column title translation for Column 1 or Column 2 or both. 

5. Click OK. 

Note  

J.D. Edwards Translation Tools accept a blank translation field only for Column Title 2 fields. 
If you are unsure about a translation, change the status of the item to 25 (Edit/Review) and 
review it later. 

 

 

Copying Existing Items 

You copy translation items for a variety of reasons. For example, you might want to use some 
of the source application names in your translation since application names are often 
alphanumeric. 

► To copy existing items 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
choose either F9202 : Data Dictionary (DD) Row / Column or F9203 : Data Dictionary 
(DD) Alpha. 

1. On the Fix/Inspect (Work With . . .) form, locate the records that you want to 
translate.  

2. Choose an item in the detail area and then click Select. 

3. On Data Dictionary Translation, click the Translation tab. 

4. On the Form menu, choose one of the following options: 

• Copy Source 

Copies the information from the source field to the target field. 

• Copy Alpha 

Copies the information for the Alpha description into the row and column target 
field. 

• Copy Row 

Copies the information for the row description into the target field for the column 
description. 

• Copy Previous 

Copies the information from the last saved translation into the target field. 

5. Click OK to save your changes. 
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Translating Processing Options 

Processing options (POs) allow users to control how an interactive or batch application 
manages data. Users choose processing options to customize the way applications and 
reports look and function.  

Because processing options are written in paragraph form and can contain hundreds of lines 
of information, they are typically one of the most time consuming components to translate. 

Understanding the Processing Option (PO) Translation Process 

Within J.D. Edwards software, users work with forms to access, view, and enter information. 
These forms are made up of many items, such as radio buttons, text fields, check boxes, and 
data dictionary-based items.  

To users, processing options appear as tabbed forms containing fields, drop-down menus, 
buttons, and other objects found on system forms. Users utilize these objects by entering 
information into these fields, choose options from these drop-down menus, click buttons, and 
so on.  

When users place their cursor over the tab name, a definition of the tab appears. You must 
translate both the tab name and its definition. In Processing Option Text Translation, the tab 
name appears followed by each object that appears on a tab. Use the PO Translation Tool to 
translate items from your Source language into your Target language. 

You translate all processing options using the Processing Options Translation Tool. In 
addition to translating items, you can retrieve and use existing translations, spell check your 
work, change the status of an item, save translated items, and view glossary definitions.  

Displaying Processing Option Items 

The F98306 : Processing Options (PO)Translation Tool allows you to search for and display 
PO items by product code, language, status, object name, or any combination of these 
criteria in the detailed area. Searching for items using these options allows you to specify the 
PO items displayed.  

► To display processing option items 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F98306 : Processing Options (PO). 

1. On Work With Processing Option Text Translation, complete any or all of the 
following fields and click Find: 

• Product Code 

• Language                                 

• Status                                   

An option that allows you to see all the details for the items in the detail area. To 
return to a summarized view, turn the option off. 
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2. In the detail area, choose the item that you want to translate and click Select. 

3. Translate your item. 

4. Click OK. 

Processing Option Text Translation Form 

After you have selected an item on the Work With Processing Option Text Translation form, 
the Processing Option Text Translation form appears. This form contains three tabs: View, 
Audit, and Glossary. Use these tabs to complete all translation requirements, including 
changing translation status, viewing item history, and comparing with the glossary content.  

Processing Option View Tab 

The View tab displays a consolidated view of information for each PO. Use it to perform 
actual translations, change item status, review translations, view object information, and so 
on.  

The View tab provides the Status and Description followed by the translation of that 
description for the selected processing option. You can view the source, translation text, or 
both depending on which of the following options you turn on: 

• Source 

• Target 

• Both 

Processing Option Audit Tab 

The Audit tab displays historical and statistical information for each PO item. Use it to view 
when the item was last translated, how many items are not translated, who last translated the 
item, and so on.  

Processing Option Glossary Tab 

The Glossary tab contains glossary information (including the Data Item Help ID Override) 
assigned to a data dictionary item. Use it to make contextual comparisons in order to more 
accurately translate an item.  

Entering Processing Option Translations 

The Processing Options Translation Tool provides multiple methods to enter translations. 
You can enter translations manually, copy the source language, or use a previous translation.  
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Processing Option Space Constraints 

For each item in the Source Tab Page or Source Tab Page fields, a fixed amount of space 
(40 bytes) is available for the target text. Because translations usually require more space in 
most target languages than they do in source languages, you might have to abbreviate your 
translations. As you type a translation, the Processing Options Translation Tool keeps track 
of the number of bytes used. When you exceed the 40 bytes allotted, the cursor stops, 
preventing you from entering any more characters. When this happens, either abbreviate the 
translation or use another term.  

See Also 
! Space Constraints in the Translation Tools Guide. 

Copying Description Data 

If no translation exists for the source term, you can use the Copy Source option to copy the 
source text term into the target text field. This copy capability helps you maintain the 
formatting of the source text.  

► To copy description data 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F98306 : Processing Options (PO). 

1. On Work With Processing Option Text Translation, locate the processing option 
records that you want to translate. 

2. Choose an item in the detail area and click Select. 

The Processing Option Text Translation form appears, displaying the Status, Source 
Description, and Target Description in the common area. 

Note 
• Tabs are used to control the processing of the associated items.  

• To see the processing option in context, you can use either the Source Preview 
or Target Preview option from the Form menu. 

 

3. Double-click the Media Object Column in the detail area to choose the desired item 
Tab for translation. 

A green check mark in the Media Object Column identifies the item as translated. 

A red �X� in the Media Object Column identifies the item as untranslated. 

The data for the selected Tab appears in the common area with the data initially 
displayed in the source and target (Tab-Page), each with two short data fields. 

4. Translate the source text on Line 1. 

5. From the form menu, choose Copy Tab. 

The term is copied from line 1 to line 2 (top to bottom).  
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6. Click OK to save the translation. 

When you click OK, the system saves the translation, updates the status, and 
displays the next item of the chosen status in the Source data field. 

When you click Save, the system saves the translation, updates the status, but does 
not move on to the next item in the list. 

Using Source and Target Preview  

The J.D. Edwards Translation Tools offer many features to help you further refine the data, 
structure, and physical appearance of your translations. The following features help you 
refine your translations:  

Source Preview This feature allows you to view source objects as they appear in the software. Use 
the source preview to review software objects in the source language for content 
and format as you make translation choices. 

Target Preview This feature allows you to view target objects as they will appear translated in the 
software. Use the target preview to review your software objects in your target 
language for content and format as you make translation choices. 

The following J.D. Edwards Translation Tools have Source Preview and Target Preview: 

• F79750 : Forms Design Aid (FDA) 

• F79760 : Report Design Aid (RDA)  

• F9203 : Data Dictionary (DD) Alpha 

• F98306 : Processing Options (PO) 

► To use source or target preview 

From the Translation Tools menu (GH791), choose either Senior Translations or Junior 
Translations, depending on whether you are a senior or junior translator, and then 
choose any translation tool with source or target preview.  

1. Choose an item in the detail area. 

2. From the Form menu, choose one of the following:  

• Source Preview 

• Target Preview 

Additional Processing Option Tool Features 

The Processing Option Text Language Translation tool has many additional features to assist 
you. 

Get Specs 

From the Form menu, you can choose the Get Specs option. This option downloads the 
latest specifications for forms and processing options for the current release. You use this 
feature when you find discrepancies between the software and preview of the forms and 
POs. 
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Top 

From the Form menu, you can choose Top to bring you back to the first item of the list in the 
current template that you are translating. You use this feature when translating processing 
option templates that are very long.  

Data Dictionary Glossary Exit 

From the Form menu, you can access the Data Dictionary translation tool. You can use the 
Data Dictionary glossary exit to update or add a Data Dictionary translation. 
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Translating Forms 

Within J.D. Edwards software, users work with forms to access, view, change, and enter 
information. Forms consist of many items, such as radio buttons, text fields, check boxes, 
and column headings that are based on data dictionary items.  

You use the F79750 : Forms Design Aid (FDA) translation tool to translate form items from 
your source language into your target language. (Only applications that are created using the 
J.D. Edwards application Forms Design Aid are translated using the F79750 : Forms Design 
Aid (FDA) translation tool.) The Forms Design Aid (FDA) translation tool does the following: 

• Displays form items in the context that they appear in the J.D. Edwards software 

• Shows related data dictionary items when available 

• Contains reference features 

• Tracks productivity 

The Form Translation Process  

Translating form items requires more than just looking at a term and entering a translation. 
The terminology you use depends greatly on the context in which the term is used.  

For example, the word job might refer to an employee�s position in a human resources 
context, but might refer to batch processing in an accounting context. So the translation you 
use in one system might not be appropriate in another. 

This concept is especially critical when translating forms because an individual form might be 
used in more than one system. In these instances, you must ensure that the translation is 
appropriate in context for both systems. 

As you translate forms, you must pay attention to overrides, context, and proposed 
translations. 

Note 

No field exists on the form for you to check if you want to apply a language override. 

 

 

Before You Begin 
! Review Additional Information: Jargon and Overrides in the Translation Tools Guide. 
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Single Line Items 

Single line items are the individual items that make up a form. These items, such as controls 
and grids, relate to a data dictionary item. The base data dictionary description is used for 
these items unless an override is applied. You can translate the following single line items 
within a form:  

Single Line Item Explanation 
Title In J.D. Edwards Translation Tools, the form title appears in the upper left hand 

corner of J.D. Edwards software forms and beneath the Form folder in the 
menu tree of the Forms Design Aid Text form.  

 

Control Controls are the text fields, check boxes, static text, and radio buttons that 
appear in J.D. Edwards forms. Many controls correspond to a data dictionary 
item.  

 

Menu Hyper Controls In J.D. Edwards software, menu hyper controls access applications and forms. 
They are the options available from the drop-down menus at the top of J.D. 
Edwards forms as well as from the Exit bar. 

 

Tabs In J.D. Edwards forms, tabs act as separators for groups of controls. Users 
click the tabs to display a new group of controls. Tabs appear in the menu 
trees (as for controls), but are labeled as tabs in the translation area when you 
choose them. 

 

Grid Items Grid items are row and column headers for the table. Grid items correspond to 
the column description for a data dictionary item. On a form, they are the 
column titles in the detail area. 

 

Text Variables In J.D. Edwards software, multiple line items are used for text strings and 
runtime text substitution. Text variables are stored as strings and can be used 
as an alternative to hard coding text strings in assignments. Developers use 
text variables instead of hard-coded text because text variables are easier to 
maintain. You translate text variables; you do not translate hard-coded text.  

 

Using Overrides 

When an English override is applied to an item within an application, it means that a 
developer overrode a data dictionary description and entered an alternate description.  

When an item does not have an English override, the base data dictionary description 
automatically appears in the Target field. Controls and grids within a form in an application 
correspond to a data dictionary item. If development has not overridden the text, you should 
assign the data item the DD Default (status 15 FDA/RDA DD Default) when you translate. 
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When an English override is applied to an item, the Text Overridden check box in the Text 
Information group is turned on in the Forms Design Aid Text form. In these cases, a language 
override is also applied automatically. You cannot clear the Text Overridden check box when 
the English description was overridden. The text must be translated because the DD Default 
cannot be used. Use the Suggestions option to ensure consistent terminology when 
translating overridden items. 

Note About Overrides Versus Data Dictionary Descriptions 

When you change a default value for a data dictionary item, the change is made dynamically 
in every instance of the software. Changes to overrides must be made to each individual 
instance. 

 

 

Removing Overrides 

If the base translation is not appropriate in the context of the application�s form, you have the 
following options:  

• Change the item to status 15 (FDA/RDA DD Default) to apply a language override. 
The new translation you enter applies only to the item for that particular application. 

• Apply an override yourself. Use status 11 (Complete) to apply a language override. 
The new translation you enter applies only to the item for that particular application.  

• Remove a language override by changing the status to 11 (Complete). When you do 
this, J.D. Edwards Translation Tools display the data dictionary translation for you to 
review and replace as necessary. 

The Forms Design Aid (FDA) Translation Tool 

The F79750 : Forms Design Aid (FDA) Tool is designed to provide contextual translation. The 
tool uses tree structures on different tabs to define the context. You use the tabs on this form 
as well as the features from the Form menu to review and translate FDA items.  

Forms Design Aid View Tab 

The View tab displays the individual items within a form. The translation functions that appear 
in the common area at the bottom of the form do not change. You can display forms, choose 
the items you want to translate, enter translations, change the status of an item, and perform 
various other tasks related to translating items. When you have selected a form title, a green 
arrow displays next to the Target data field to assist you in determining where you are in the 
list. 

Forms Design Aid Audit Tab  

The Audit tab displays the statistics for items contained in the form. You cannot enter or 
change any of the displayed items. The data field information in the common area remains 
the same as on the original View tab. 
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Forms Design Aid Tasks Tab  

The Tasks tab allows you to view tasks from within the F79750 : Forms Design Aid (FDA) 
application. You translate tasks from the Task Language Translation program (P799000). 

Forms Design Aid Data Dictionary Tab 

The Data Dictionary tab allows you to view the Alpha, Row, Column, or FDA text that appears 
on the form within the F79750 : Forms Design Aid (FDA) application. You translate data 
dictionary items from the Data Dictionary Language Translation program (P799201). Double-
click a data dictionary item in the tree to access the Data Dictionary Language Translation 
program. 

Forms Design Aid Glossary Tab  

The Glossary tab allows you to view a glossary for a data item. You can view the source 
glossary on this tab, but you cannot revise the glossaries on this tab. You translate data 
dictionary items and glossaries from the Data Dictionary Language Translation program 
(P799201). Double-click a data dictionary item in the tree on the Data Dictionary tab to 
access the Data Dictionary Language Translation program. 

Forms Design Aid Processing Options Tab  

The Processing Option tab allows you to view processing options associated with a program. 
You translate processing option items from the Processing Option Text Translation program 
(P7998306). Double-click an item in the menu tree to access the Processing Option Text 
Translation program. 

Entering Form Translations 

Forms can be accessed from multiple J.D. Edwards programs and menus. The Form Name 
begins with the letter W, followed by the application code and a letter. For example, in the 
Form Name W0101A, W indicates that it is a form, 0101 indicates that the form belongs to 
program P0101, and A indicates that it is the first form for the application. When you translate 
forms, you translate all the single line items for that form, such as form title, controls, menu 
hyper controls, grids items, and so on. 

Form Space Constraints 

Grid items, titles, and certain controls (radio buttons, text boxes, and static text) are 
measured in pixels, while menu hyper items, tabs, and the remaining controls are measured 
in characters. Because terms might take up more space in the Target language than in 
Source language, it can be difficult to meet space constraints, and you may have to 
abbreviate your translations.  

You can view the space available and space used in the Text Information area of the Forms 
Design Aid Text form. As you tab out of a field, the system calculates the space used. If you 
exceed the space available, the cursor stops, and you must shorten the translation before 
you can save it.  
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Before You Begin 
! Review Additional Information: Jargon and Overrides in the Translation Tools Guide. 

Translating Tabs, Controls, and Titles 

Tabs, controls, and titles are all translated in the same way. When you choose one of these 
items, the Source term appears in the Source field, and you enter the translation in the Target 
field.  

► To translate tabs, controls, and titles 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F79750 : Forms Design Aid (FDA). 

1. On Work with Forms Design Aid Text, complete the following fields and click Find: 

• Product Code 

• Status                                   

• Language                                 

• Status Details 

This option allows you to see all of the details for the items in the detail area. To 
return to a summarized view, turn this option off. 

2. Click an item in the detail area and click Select.  

3. On Forms Design Aid Text, click the View tab and then click an item in the menu tree.  

4. Enter your translation in the Target data field. 

5. Click OK to save your translation. 

When you click OK, the system saves the translation, updates the status, and 
displays the next item of the chosen status in the Source data field. 

When you click Save, the system saves the translation and updates the status, but 
does not move on to the next item in the list. 

Translating Menu Hyper Items 

When translating menu hyper items, you must translate both the long and short text 
descriptions. Each menu hyper item also has a keyboard shortcut, or hot key, and, if a menu 
hyper item is associated with the text descriptions, this key must be included in the 
translation. The following table describes the parts of a menu hyper item:  
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Menu hyper items 
short text 
descriptions 

Short text descriptions are the abbreviated menu options that access 
applications. 

Menu hyper item long 
text descriptions 

Long descriptions provide an unabbreviated description of menu hyper items.  

Hot keys Hot keys are the keyboard shortcuts used to choose menu options. Users can 
choose a menu option by pressing Alt + (hot key). A letter in the menu option 
acts as the hot key and is indicated by & (ampersand) preceding the letter. For 
example, the menu hyper short description File (&F) indicates that the hot key 
for the File option is F. 

Important 

If you have the literal & (ampersand) in your translated text, you must enter && (two 
ampersands) to represent the symbol. If you do not enter && (two ampersands), the software 
represents your translation as a hot key. 

 

When you choose a menu hyper item, both the menu hyper short and menu hyper long text 
descriptions appear in the common area of the Forms Design Aid Text form. 

► To translate menu hyper items 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F79750 : Forms Design Aid (FDA). 

1. On Work with Forms Design Aid Text, complete the following fields and click Find: 

• Product Code 

• Status                                   

• Language                                 

• Status Details 

This option allows you to see all the details for the items in the detail area. To 
return to a summarized view, turn this option off. 

2. Choose an item in the detail area and click Select.  

3. On Forms Design Aid Text, choose a menu hyper item in the menu tree. 

Both the short and long text descriptions appear in the common area. 

4. Type a translation for the menu hyper item short description. 

5. Type a translation for the menu hyper item long description. 

6. Click OK. 

When you click OK, the system saves the translation, updates the status, and 
displays the next item of the chosen status in the Source data field. 

When you click Save, the system saves the translation and updates the status, but 
does not move on to the next item in the list. 
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Translating Grid Items  

Grid items are the column headings that appear in the detail area of J.D. Edwards forms. 
Each grid item can contain multiple words. Two lines are allocated to each grid item (Column 
1 and Column 2). When you select an item, two translation fields appear in the common area.  

When you choose a grid item, the Space Used field displays the amount of space used for 
both the top and bottom translation fields. 

► To translate grid items 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F79750 : Forms Design Aid (FDA). 

1. On Work with Forms Design Aid Text, complete the following fields and click Find: 

• Product Code 

• Status                                   

• Language                                 

• Status Details 

This option allows you to see all the details for the items in the detail area. To 
return to a summarized view, turn this option off. 

2. Choose an item in the detail area and click Select.  

3. On the View tab, click a grid item in the menu tree. 

4. Translate the item in the Target field. 

5. Click OK. 

When you select OK, the system saves the translation, updates the status, and 
displays the next item of the chosen status in the Source data field. 

When you select Save, the system saves the translation and updates the status, but 
does not move on to the next item in the list.  
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Translating Reports 

You create reports using the J.D. Edwards application named Report Design Aid (RDA). 
Reports are generally referred to as Universal Batch Engines (UBEs) because they not only 
present data in report form, but they also can be used to create batch programs that perform 
certain actions.  

Reports are used to view trends, outcomes, and information from J.D. Edwards applications. 
Use the RDA Translation Tool to translate interface items of J.D. Edwards reports from the 
source language into your target language.  

The Report Translation Process 

You translate reports by selecting untranslated items within your assigned system. You 
should translate report items in the following manner: 

1. Display the first report in the list 

2. Translate the following items:  

1. Report title 

2. Page headers 

3. Page details 

4. Columns 

Note 
Section titles do not need to be translated.  

 
3. Save your work 

When you save a translation, the J.D. Edwards Translation Tool displays the next item of the 
chosen status. Continue translating items until no untranslated items remain. 

Before You Begin 
! Review Additional Information: Jargon and Overrides in the Translation Tools Guide. 

Versions 

Different versions of the same report often exist. The base report or template is marked with 
a plus sign (+), and versions are usually named XJDE0001, XJDE0002, ZJDE0001, and so 
on. 

A version is a user-defined set of specifications. These specifications control how 
applications and reports run. You use versions to group and save a set of user-defined 
processing option values or data selection and sequencing options. Interactive versions are 
associated with applications (usually as a task selection). Batch versions are associated with 
batch jobs or reports. To run a batch process, you must choose a version.  
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Using Overrides 

When an English override is applied to an item within an application, it means that a 
developer overrode a data dictionary description and entered an alternate description.  

When an item does not have an English override, the base data dictionary description 
automatically appears in the Target field. Controls and grids within a form in an application 
correspond to a data dictionary item. If development has not overridden the text, you should 
assign the data item the DD Default (status 15 FDA/RDA DD Default) when you translate. 

When an English override is applied to an item, the Text Overridden check box in the Text 
Information group is turned on in the Forms Design Aid Text form. In these cases, a language 
override is also applied automatically. You cannot clear the Text Overridden check box when 
the English description was overridden. The text must be translated because the DD Default 
cannot be used. Use the Suggestions option to ensure consistent terminology when 
translating overridden items. 

Note About Overrides Versus Data Dictionary Descriptions 

When you change a default value for a data dictionary item, the change is made dynamically 
in every instance of the software. Changes to overrides must be made to each individual 
instance. 

 

 

Removing Overrides 

If the base translation is not appropriate in the context of the application�s form, you have the 
following options:  

• Change the item to status 15 (FDA/RDA DD Default) to apply a language override. 
The new translation you enter applies only to the item for that particular application. 

• Apply an override yourself. Use status 11 (Complete) to apply a language override. 
The new translation you enter applies only to the item for that particular application.  

• Remove a language override by changing the status to 11 (Complete). When you do 
this, J.D. Edwards Translation Tools display the data dictionary translation for you to 
review and replace as necessary. 

The Report Design Aid (RDA) Translation Tool 

The Report Design Aid (RDA) Translation Tool consists of the following tabs: View, Audit, 
Tasks, Data Dictionary, Glossary, and Processing Options. 

Report Design Aid View Tab 

On the View tab of the Report Design Aid Text form, you can display all of the items for the 
selected report in a menu tree view. When you click an item in the tree, the current Source 
term, the Target term, and the status appear in the data fields of the common area.  
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Report Design Aid Audit Tab 

The Audit tab displays the selected statistics for items contained in the report. You cannot 
enter or change any of the displayed items. The information in the common area remains the 
same as appears on the View tab. 

Report Design Aid Tasks Tab 

The Task tab lists the selected report�s tasks in a tree format for you to review. All of the 
entries are derived from the database by the system and cannot be changed.  

Report Design Aid Data Dictionary Tab 

The Data Dictionary tab contains the selected report�s data items and user defined codes 
(UDC) in a menu tree view. You cannot enter or change any of the displayed items.  

Note  

You can access the data dictionary translation tools to edit data dictionary and user defined 
code items from the RDA tools by double-clicking on a node from the data dictionary folder or 
by choosing DD from the Form menu. 

 

 

Report Design Aid Glossary Tab 

The Glossary tab contains the selected data item�s glossary text. The glossary tab allows you 
to view the glossary for the Source and Target language. You cannot edit the glossary from 
this tab. To edit the glossary, choose DD from the Form menu. In addition, the data field 
information in the common area remains the same as appears in the View tab.  

Report Design Aid Processing Options Tab 

On the Processing Options tab, you can view all of the selected report�s processing options 
items for translation in the menu tree format.  

Note  

You can access the Processing Option text translation tool to edit processing option text from 
the RDA tools by double-clicking on a node from the Processing Options folder. 
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Translating Report Titles, Page Headers, Page Details, and 
Columns 

Reports can be accessed from multiple J.D. Edwards programs and menus. The report name 
begins with the letter R, followed by the application name. For example, in the report name 
R01010Z, R indicates that it is a report and 01010Z indicates that the report belongs to 
program P0101. When you translate reports, you translate all of the items for that report, 
such as the report title, page headers, page details, and columns.  

► To translate report titles, page headers, page details, and columns 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F79760 : Report Design Aid (RDA). 

1. On Work with Report Design Aid Text, complete the following fields and click Find: 

• Status                                   

• Language                                 

• Program ID 

Optional. In the detail area. 

2. Click an item in the detail area and click Select.  

3. On Report Design Aid Text, click the View tab, and then click an item in the menu 
tree.  

4. Enter your translation. 

5. Click OK to save your translation. 

When you click OK, the system saves the translation, updates the status, and 
displays the next item of the chosen status in the Source data field. 
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Translating Solution Explorer Tasks 

Tasks are menu items and application names that appear in J.D. Edwards software. The 
Solution Explorer task translation tools display the menu name, followed by each application 
that appears when users choose the menu in J.D. Edwards software.  

You use the following Solution Explorer tools to translate solution tasks:  

• F9000 : Solution Explorer Tasks 

• F9005 : Solution Explorer Variant Tasks 

• F9006 : Solution Explorer Variant Task Details 

The Solution Explorer Task Translation Process 

To users, menus and tasks appear as lists, or trees, from which users choose applications in 
J.D. Edwards software. These trees are multi-tiered, and often contain several levels of 
options. When users place their cursor over the menu or application name, a definition 
appears. You must translate the name and its definition. In the Solution Explorer Task 
translation tool, each tab name is followed by each object in a menu tree.  

The Solution Explorer Task Translation Tool  

You translate all menus and tasks items using the Solution Explorer task translation tool. In 
addition to translating items, you can retrieve and use existing translations, check the spelling 
of your work, change the status of an item, save translated items, search for and replace 
target text, and so forth.  

Working with Task Translation 

The entry point to the Solution Explorer task translation tool is the Work With Task 
Translations form. Use this form to search for and select items that needs to be translated. 
You can search for items using a variety of search criteria, such as language, product code, 
and translation status.  

Solution Explorer Tasks Translation Form 

After you have selected an item from the Work With Task Translations form, the Task 
Translation form appears. This form contains two tabs: View and Audit. Use these tabs to 
complete all translation requirements, including changing translation status and viewing item 
history.  

Solution Explorer Tasks Translation View Tab 

You can choose an item to translate or edit by clicking in the menu tree. When you choose an 
item, the tool highlights the item and populates the source and target fields with the 
associated text.  
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The View tab displays a consolidated view of information for each menu or task item. Use this 
tab to perform actual translations, change item status, view object information, and so on. 

Solution Explorer Tasks Translation Audit Tab 

The Audit tab displays historical and statistical information for each menu or task item. You 
can review audit information for a delta item to see who translated it last, its source, and so 
on. You do not need to check this information as part of the daily translation process. 
However, it is a vital part of troubleshooting a problem item caused by the translation tools or 
the delta process.  

You can also translate the item currently displayed on this form, although you cannot 
translate additional items. 

Translating Menu or Task Items 

The Solution Explorer task translation tools allow you to search for and display menu and 
tasks items by various search criteria, including product code, language, status, task, or any 
combination of these criteria. Searching for items using these options allows you to specify 
the menu and task items displayed.  

Note about Item Searches 

The Solution Explorer task translation tools retrieve the task items that match the search 
criteria and display them in the detail area. 

Any language that you search on that is not specified in your user profile is read-only. 

If you leave any of the fields blank, the system uses the default value of * (asterisk), which 
equals a search for all items. 

 

 

► To translate menu or task items 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F9005 : Solution Explorer Variant Tasks. 

1. On Work With Variant Description Translations, complete any of the following fields 
and click Find:  

• Product Code 

• Status 

• Task View ID                             

• Language                                 
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2. Choose the item that you want to translate and click Select. 

The Variant Description Translation form appears.  

3. Choose an item from the menu tree. 

4. Translate the item. 

5. Click OK. 
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Translating User Defined Codes 

Within J.D. Edwards forms, users must often enter information into text fields. Many times, 
users can choose the information from a list of items called User Defined Codes (UDCs). 
UDCs are codes and descriptions in J.D. Edwards software that provide users with an easy 
way to choose a value from a list. UDCs are stored in tables within J.D. Edwards software, 
and are accessed from these tables.  

Each UDC contains a description of the option as well as a code for that option. Only the 
descriptions must be translated; the codes remain the same in every language. 

The User Defined Code Translation Process 

User Defined Codes (UDCs) are stored in tables that contain at least one item and can hold 
an unlimited number of items. The User Defined Code (UDC) translation tool displays all 
items in a table at once in order for you to view them in context.  

The User Defined Code (UDC) Translation Tool  

You translate all User Defined Codes (UDCs) from the J.D. Edwards UDC translation tools. In 
addition to translating items, you can retrieve and use existing translations, check the spelling 
of your work, change the status of an item, save translated items, search for and replace 
target text, and view glossary definitions.  

You use two tools to translate UDCs. You choose which tool to use based on what you want 
to translate. The function of each tool is as follows: 

F0004 : User Defined 
Code (UDC) Types 

Use this tool if you are translating only UDC Types. UDC Types are the actual 
code table titles. 

F0005 : User Defined 
Codes (UDC) 

Use this tool if you are translating only the UDC Codes or want to see all 
untranslated UDC items. This tool shows you all the UDC Codes as well as the 
associated UDC Types, regardless of their translation status. 

Both of these tools function similarly. However, if you decide to start translating using the 
F0005 :  User Defined Codes (UDC) tool, you must use the F0004 : User Defined Code 
(UDC) Types tool to verify that you have translated all UDC Types. You must do this because 
the UDC Code tool does not show you any untranslated code types if no untranslated UDC 
Codes exist. Both of the UDC translation tools consist of the Work With User Defined Code 
Type Language Translation form and the User Defined Codes Translation form. 

Work With User Defined Code Type Language Translation Form / Work 
With User Defined Code Language Translation Form 

The entry points to the User Defined Code (UDC) Translation tool are either the Work With 
User Defined Code Type Language Translation form or the Work With User Defined Code 
Language Translation form. Use these forms to search for and choose items that you want to 
translate. You can search for items using various search criteria, such as language, product 
code, translation status, and UDC types. 
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You use the following four data fields to search for UDC items to translate: 

• Product Code  

• Language (L) 

• Status 

• UDC Types  

These data fields allow you to specify the limits to be used in selecting the items to be 
translated. The most restrictive specification is a specific code in each data field; the least 
restrictive specification is the wild card * (asterisk) in a data field.  

User Defined Codes Translation Form 

After you have chosen an item from the Work With User Defined Code Type Language 
Translation form or the Work With User Defined Code Language Translation form, the User 
Defined Codes Translation form appears. This form contains the following tabs: View, 
Glossary, and Audit. Use these tabs to complete all translation requirements, including 
changing translation status, comparing glossary content, and viewing item history.  

Choosing Items from the Tree 

You choose items to translate from the View tab. The View tab displays a consolidated view 
of information for each UDC item. The tree view displays all items according to the item you 
selected on the �Work With�� form. The information that is displayed depends on the display 
options you choose. You can use the View tab to select text for translation, perform actual 
translations, change item status, view object information, and so forth.  

You can choose an item to translate or edit by clicking it in the menu tree. When you choose 
an item, the system populates the following fields:  

• UDC Type 

• UDC Code 

• Source 

The Source fields always populate with the source text. 

• Target 

The Target fields only populate when a translation exists. 

► To choose an item from the tree 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F0005 : User Defined Codes (UDC). 

1. On Work With User Defined Code Language Translation, complete the following 
fields and click Find: 

• Product Code 

• Status 

• Language                                 

• UDC Types 
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2. Click the item in the detail area that you want to translate, and click Select. 

The User Defined Codes Translation form appears with the item you chose displayed 
in the Tree view. 

3. In the menu tree, click the item you want to review or translate. 

Reviewing Glossary Information for UDCs 

UDCs can be associated with data items. The Glossary tab contains information that 
describes that data dictionary item. You use the Glossary tab to make contextual 
comparisons in order to accurately translate an item.  

► To review glossary information for UDCs 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F0005 : User Defined Codes (UDC). 

1. On Work With User Defined Code Language Translation, locate the user defined 
code records that you want to translate.  

2. Choose an item in the detail area and click Select. 

3. Choose an item from the tree menu. 

4. On User Defined Codes Translation, choose an item and click the Glossary tab. 

5. Review the glossary. 

The Glossary tab form contains information assigned to a data dictionary item. Use it 
to make contextual comparisons in order to accurately translate an item. You can 
translate the item currently displayed on this form, although you cannot translate 
additional items. You translate the glossary using the Data Dictionary Language 
Translation program (P799201). 

Translating User Defined Code Items 

You have three options when translating user defined code items: you can enter translations 
manually, copy the source item, or use the suggestion process. 

The UDC Translation tool allows you to search for and display UDC items using various 
search criteria, which you enter in the data fields of the form. The search criteria include 
product code, language, status, UDC types, or any combination of these criteria.  

► To enter a translation manually 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F0005 : User Defined Codes (UDC). 

1. On Work With User Defined Code Language Translation, locate the user defined 
code records that you want to translate.  

2. Choose an item and click Select. 

The User Defined Codes Translation form appears, displaying the source term in the 
Source field.  
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3. In the Target field, enter the translated text. 

4. Click OK. 

When you click OK, J.D. Edwards translation tools saves the translation and updates 
the status. You have to click Next to move to the next untranslated item. 

Copying the Source Item 

You can either enter a translation manually or use the following features to copy information 
into a target field.  

► To copy the source item 

From the Translation Applications menu (GH791), choose either Senior Translations or 
Junior Translations, depending on whether you are a senior or junior translator, and then 
F0005 : User Defined Codes (UDC). 

1. On Work With User Defined Code Language Translation, locate the user defined 
code records that you want to translate.  

2. Choose an item in the detail area, and then click Select. 

The User Defined Codes Translation form appears, displaying the source item in the 
Source field. 

3. Choose a record in the menu tree. 

4. On the toolbar of the form, click Form and then click the Copy Source option. 

The source item appears in the Target field. 

5. Click OK to save your translation. 

Space Constraints 

A fixed amount of space is available for the translated text of each item. Because translated 
text usually requires more space for most target languages, you might have to abbreviate 
your translations.  
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Translating across Multiple Releases or Environments 

You might have to translate more than one release at a time if you translated:  

• In a prior release and your translations need to be matched in a current release 

• In the current release and you want to leverage those translations again  

• In the current release and your translations need to be matched in a prior release 

The Multiple Release Exact Match program (P7903) uses source text to locate target text 
with the exact same text strings. Using Multiple Release Exact Match across multiple 
releases or environments has the following benefits: 

• Ensures no disconnect between source and target text 

• Provides cost-effective budgeting of your language assets 

• Provides consistent terminology 

• Eliminates production time for matching text 

• Accelerates the quality assurance process 

Matching Criteria for Updates and Audits in the Multiple Release 
Exact Match Program (P7903) 

The Multiple Release Exact Match program (P7903) requires specific matching criteria in 
order to update status, audit trail, and target translations. The following table documents 
those criteria and what the program does when it finds or does not find the specified criteria. 
The table also shows which source and target translation items it uses when matching them 
for updates and for creating audit trails. 

 

Criteria Program Response 
Reports and Forms (Data 
Dictionary Verification and 
Status Update) 

Data Dictionary Verification 

• The program verifies the source data dictionary items against 
the Data Field Display Text table (F9202) translations to 
ensure that a data item name exists but no text overrides 
exist. 

Data Dictionary Status Update 

• If the program finds a data item name and no text override, it 
updates the data dictionary status to 15 (DD Default) when 
you run the Multiple Release Exact Match program in final 
mode.  

Source If the program detects blank source items, the status of the item is 
updated to Skip (30) when you run the Multiple Release Exact 
Match program in final mode. 

Primary Source Text The program always matches the primary source text against the 
text in the secondary search environment. 

Primary Source and Status The primary source text and status must exist, and the program 
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always verifies against the primary target. 

Secondary Source The secondary source, status, and target must exist for an exact 
match. 

Status Verification The Multiple Release Exact Match program verifies whether the: 

• Primary Date translated is a null (does not exist) date 
• Secondary Date Translated is greater than or equal to the 

Primary Date Translated 
• Primary Target is null (does not exist) or blank 
• Secondary Complete Status is equal to Secondary Search 

Complete Status 
Audit Trail In the Primary Update Code Page Environment, the Audit Trail 

information updates: 

• Last Translator to XTRANS (use XTRANS with 
Search/Replace & Review Approved) 

• Date Translated to Secondary Last Date Translated 
• User, PID, Job, Date, and Time to the Current Audit 

Information 
• Primary Selection Status (20) to Primary Update Status (36) 

 

► To translate across multiple releases or environments 

You must be a Senior Translator to run the Multiple Release Exact Match program (P7903). 

From the Translation Applications menu (GH791), choose Exact Match Quality 
Assurance, and then Translation Tools.  

1. On J.D. Edwards Translation Tools, from the form menu, choose Exact Match. 

2. Complete the criteria in the following categories:  

• Language                                 

You can change languages to submit more than one language. 

• Mode 

You can run the process in Preliminary or Final mode. 

• Preliminary 

The system does not update records. It only reports the total number of 
records. 

• Final 

The system updates records to the primary compare and code page 
environments. 
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Note 
You should run the Exact Match process in Preliminary mode first. Preliminary 
mode allows you to verify your record totals. 

 
• Selection Filter 

• Primary Product Code 

You use the primary product code in conjunction with the status selection in 
the primary compare environment to define your record set.  

Note 
You should repeat the process for each individual product code. If you do not 
enter a value in the Primary Product Code field, the system searches all product 
codes for matching records. 

 
• Status 

• Primary Selection Status 

The record status that the system selects from primary environment. This 
value is typically 20 (Untranslated). 

• Secondary Complete Status 

The record status that the system matches against the selection status in the 
secondary environment. This value is typically 11 (Complete).  

• Primary Update Status 

The record status that the system uses to update records in the primary 
environment. This value is typically 36 (Exact Match). 

• Primary Skip Status 

The record status that the system uses to update blank records in the 
primary environment. This value is typically 30 (Skip). 

• Compare Environments 

• Primary Update 

The compare environment that the system uses to select and update 
matching records that it finds from the secondary environment.  

• Secondary Search 

The compare environment that the system uses to verify the secondary 
complete status and the source text of the match type.  

• Code Page Environments 

• Primary Update 

In Final mode, the code page environment from which the system updates 
the secondary code page environment after a match is found. 
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• Secondary Search 

Once the match is found the secondary compare environment, the code 
page data that the system uses to update the primary environment.  

• Match Type 

• None 

No match is required. 

• Source and Key 

The source and the primary key of each table must match. 

• Source and Product Code 

The source term and product code must match.  

• Source 

Same term (Default) must match but in any product code. It does not have to 
be the product code that you specified in the Primary Product Code field. 

3. In the detail area, choose the tables that you want to include in the exact match 
process. 

a. From the Form menu, choose one of the following: 

• Yes 

Include all tables in the exact match process. 

• No 

Exclude all tables from the exact match process. This option clears all tables 
from the process so that you can select only those you want.  

b. Alternatively, you can include or exclude tables from the exact match process by 
double-clicking a cell in the Include column and typing one of the following 
values:  

• 1 

Include the table in the exact match process. 

• 0 

Exclude the table in the exact match process. 

4. From the Form menu, choose Submit.  

Alternatively, you can choose the Submit button on the header of the form. 

Clicking Submit runs the Multiple Release Exact Match batch process (R79850) and 
produces a report. 

After you run the Exact Match process in Final Mode, you should review and approve the 
results.  
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Additional Information: Product Codes 

The following table shows some of the product codes for the J.D. Edwards verticals and their 
systems. For an up-to-date and comprehensive list, see user defined code (98/SY). 

Product Code Description 
00 Foundation Environment 

01 Address Book 

02 Electronic Mail 

03 Accounts Receivable 

03B Enhanced Accounts Receivable 

03C Issue Management System 

0301 Credit Management 

04 Accounts Payable 

05 Time Accounting/HRM Base 

05A J.D. Edwards HR & PR Foundation 

05C J.D. Edwards HR & PR Foundation - Canadian 

05T Time Entry 

05U J.D. Edwards HR & PR Foundation - US 

06 Payroll 

07 Payroll 

07S Payroll SUI 

07Y US Payroll Year End 

08 Human Resources 

08B Benefits Administration 

08C J.D. Edwards HR Canadian 

08H Health and Safety 

08P Position Control 

08R Recruitment Management 

08U J.D. Edwards HR - US 

08W Wage and Salary 

09 General Accounting 
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Product Code Description 
09E Expense reimbursement (ERS) 

10 Financial Reporting 

10C Multi-Site Consolidations  

11 Multi-Currency/Euro 

11C Cash Basis 

12 Fixed Assets 

13 Equipment Plant Management 

14 Modeling, Planning, Budgeting 

15 Property Management 

16 Profit Management (EPS) 

17 Customer Service Management System 

17A Ariba Integration 

17C Call Management (part of CSMS) 

17X Travel & Expense Mgt Powered by Extensity  

18 Time Management 

19 Utility CIS 

20 Energy base 

21 Lease Management 

2101 MTI Electrical Distribution 

22 Production 

23 Revenue Distribution 

24 Gas Contracts 

25 Joint Interest Billing 

26 Gas Balancing 

27 Investor Services 

29 AFE Accounting 

30 Product Data Management 

30A Product Costing 

3010 Process Data Management 

31 Shop Floor Management 
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Product Code Description 
31A Manufacturing Accounting 

3110 Process Control 

32 Sales Configurator 

32C CustomWorks Configurator 

33 Capacity Planning 

34 Requirements Planning 

34A Advanced Planning & Scheduling (APS) 

35 Enterprise Facility Planning 

36 Forecasting 

37 Quality Management 

38 Agreement Management 

39 Advanced Stock Valuation 

40 Inventory/OP Base 

4010 Advanced Price Adjustment 

41 Inventory Management 

41B Bulk Stock Management 

42 Sales Management 

42A Lead Opportunity Management 

42B Sales Order Entry 

42E ECS Sales Management 

43 Procurement 

44 Subcontract Management 

44H Homebuilder Management 

4401 Homebuilder Management 

45 Advanced Pricing 

46 Warehouse Management 

47 Electronic Commerce 

48 Work Order Processing 

48S Service Billing 

49 Transportation Management 



 72

Product Code Description 
50 Job Cost Base 

51 Job Costing (Job Cost Accounting) 

52 Contract Billing 

53 Change Management 

55-59 Reserved for Clients 

60-69 Reserved for JDE Custom 

70 Multi-National Products 

71 Client Server Applications 

72 WorldVision 

73 M&D Complementary Products 

74 EMEA Localization 

74H Hungary 

74I Ireland 

74L Portugal 

74M Denmark Localization 

74N Nordics Localization 

74O Norway Localization 

74P Poland Localization 

74R Russian 

74S Spain Localization 

74T Turkey 

74W Sweden Localization 

74Z Czech Republic 

75 ASEAN Localization 

75A Australian Payroll  

75C China 

75H Thailand Localization 

75I India 

75K Korea Localization 

75N New Zealand 
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Product Code Description 
75T Taiwan Localization 

75Z New Zealand Localization 

76 Latin American Localization 

76A Argentina Localization 

76B Brazil 

76C Columbia Localization 

76H Chile Localization 

76M Payroll (Mexico) 

76P Peru Localization 

76V Venezuela Localization 

77 Canadian Payroll 

77Y Canada Payroll Year End 

79 Translation Tools 

80 Business Intelligence 

81 DREAM Writer (WorldSoftware only) 

82 World Writer 

83 Management Reporting - FASTR 

84 Distributive Data Processing 

85 Custom Programming 

86 Electronic Doc. Interchange 

87 JDE Internal 

88  Cautious Purge System 

89 Conversion Programs 

91 Documentation 

92 Computer Assisted Design 

93 Computer Assisted Programming 

94 Security Officer 

95 Sleeper  

96 Computer Operations 

96P NO INFO ON THIS SYSTEM 
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Product Code Description 
97 Software Installation 

98 Technical Tools 

98E Electronic Burst and Bind 

98FT Form Type 

98SA Sample Application 

99 Technical Tools-Internal 

99D Technical Tools-DASD Sizer (reporting syst. 
only) 

99M Technical Tools-Masters/Update (reporting 
syst. only) 

99P NO INFO ON THIS SYSTEM 

D3N dcLINK (data collection) 

H00 Foundation (UDC only) 

H01 Address Book (incl. ALL mail) 

H03 Accounts Receivable 

H03B New Accounts Receivable 

H04 Accounts Payable 

H05 Standalone Time Accounting 

H07 Payroll 

H08 Human Resources 

H09 General Accounting 

H12 Fixed Assets 

H13 Plant/Equipment Mgmt 

H15 Commercial Property Management 

H30 Product Data Management 

H301 Process Data Management 

H31 Shop Floor Management 

H311 Process Control 

H32 Configuration Management 

H33 Capacity Requirements Planning 

H34 DRP/MRP/MPS 
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Product Code Description 
H35 Enterprise Facility Planning 

H36 Advanced Forecasting 

H40 Inventory/OP Base  

H41 Inventory Management 

H415 Bulk Inventory Management 

H42 Sales Order Processing 

H43 Procurement 

H44 Contract Management 

H44H Homebuilder Management 

H45 Sales Analysis 

H46 Warehouse Management 

H50 Job Cost Base 

H72 Client/Server Base 

H73 Client Service - A/P Voucher Entry 

H74 CS - Pay Time Entry 

H75 CS - Sales Order Entry 

H76 CS - Training & Development 

H78 CS - Travel Expense Management 

H79 Translation Tools 

H90 J.D. Edwards Tools 

H91 Design Tools 

H92 Interactive Engine / OL 

H93 Data Base and Communications 

H94 Batch Engine 

H95 Technical Resources/Applications 

H96 Deployment 

H97 Automated Testing Tools  

H98 Internet 

H99 Product Version Control 

H99P Technical Tools-OWPVC Internal 
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Product Code Description 
JE42 Sales Order/Pricing (ECS Enhancements) 

JE44 Distribution Contracts (ECS Enhancements) 

JE48 Automated Gantry Inter. (ECS Enhancements) 
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Additional Information: Status Codes 

Translation tools use three types of status codes to help you identify where items are in the 
translation process.  

• Status 

• Reason 

• Skip 

The following tables list the status codes in J.D. Edwards Translation Tools.  

Status codes identify the status associated with a text item. The status allows editors and 
translators to make changes according to the change type. 

The following table illustrates some of the status codes that you can use. For an up-to-date 
and comprehensive list, see the following user defined code lists. 

• H79/TS � for status codes 

• H79/CT � for reason codes 

• H79/SR - for skip statuses 

 

Numeric Status 
Code Description 
01 Not Translated. Assign this status to source terms that you cannot translate into 

the target language.  

11 Complete. After you have translated an item and saved it, you must change its 
status to complete. All translation tools automatically change the status to 
Complete when you save the translation using the Senior Translations version. 

Only items with a Complete (11) or Edit/Review (25) status appear in the final 
translated software. Therefore, it is extremely important that you save each 
translation and make sure the status changes to Complete. 

15 Data Dictionary Default. The Forms Design Aid (FDA) and Report Design Aid 
(RDA) translation tools use this status code.  

20 Untranslated. This is the untranslated status for all items in J.D. Edwards 
software. 

25 Edit (Review). In the Junior Translations version, the system changes the status 
to Edit when you press OK. When another translator edits the translation and 
finalizes it, the system changes the status to Complete (11).  

30 Other (Skip Reason). Use the Skip Reason to force the source text to appear in 
the application. 

60: The item contains test data. 

61: Unnecessary for all languages. 

62: Unnecessary for this language. 

64: Waiting for application development. 
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35 Translation Memory. At this status, the item has been exported to a translation 
memory and then reimported to J.D. Edwards software. 

99 Purge from System. The Delta Process automatically assigns this status; the user 
never assigns this status. 

Reason codes are codes that define the change to the text. Many items will be set to 
untranslated with a type of new item. 

Numeric Status 
Code Description 
40 New Item  

41 Text and Size Change  

42 Text change  

43 Minor Text Change  

44 Size Change  

Skip Reason allows the editor or translator to assign the reason for skipping a text edit. 

Numeric Status 
Code Description 
00 Normal  

60 Test Data. The item contains test data. 

61 Unnecessary for all languages.  

62 Unnecessary for this language. The item is specific to the U.S. or Canada.  

63 Waiting for application developer.  

64 Insufficient Length. The translation does not fit in the allotted space. 
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Additional Information: Jargon and Overrides 

The use of overrides and jargon is the most complex aspect of translating J.D. Edwards 
software. Jargon and overrides are concepts that apply to the Data Dictionary (DD), Forms 
Design Aid (FDA), and Report Design Aid (RDA) translation tools.  

Jargon and overrides tell the software what type of information should display in certain 
situations. Developers apply jargon when modifying items within the Data Dictionary, and 
they apply overrides when modifying the descriptions that appear on forms. 

You might see different text on a form if you run it from the Fast Path instead of running it 
from a task. 

Developers must define different field descriptions on the same form depending on how the 
programs are called. For example, program P1234 calls form W1234A, which has a field 
description "abc." If another program calls form W1234A, for example P5678, then form 
W1234A displays this field description as "xyz" instead of "abc." The following table illustrates 
this concept: 

Program  Form  Data Item 
P1234 calls W1234A displays abc 

P5678 calls W1234A displays xyz 

 

According to programming standards, programmers must program jargon and overrides 
without using event rules (ER). Runtime engines execute the ER. When you run a program 
using the Fast Path, the runtime engines execute this ER.  

To understand jargon and overrides, you must first understand the Data Dictionary. 
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The Data Dictionary 

The Data Dictionary (DD) stores the descriptions for all the controls, text fields, buttons, F1 
help, and other items that appear on forms in J.D. Edwards software. Each data dictionary 
item contains the following four descriptions: alpha description, row description, column 
description, and glossary.  

• Alpha description  

The alpha description is the title of the F1 Help in J.D. Edwards software, which is the 
glossary entry in the software.  

• Row description  

When a data dictionary item is used as a control, such as a field, check box, or radio 
button, the row description is used as the text for the control.  

• Column description  

When the data dictionary item is used as a grid item, such as a column heading in a 
report or form, the column description is used as the text for the grid item. 

• Glossary  

The glossary is the help text that appears when a user presses F1. It explains what a 
field in a form means or how it used in the software. The alpha description appears 
as the title of the help text. 

Data Dictionary Jargon 

Each data dictionary item can be used on many different forms. As developers use and reuse 
data dictionary items, they can modify the descriptions for the items. To do this, they apply 
jargon. Jargon allows developers to customize data dictionary text so that an alternate 
description appears, depending on the context and system code in which the item is used.  

Developers can apply two types of jargon to data dictionary items:  

• Alpha and glossary 

• Row and column 

Jargon is applied to form controls and grid items when the data dictionary default value is 
used. Using the data dictionary is always preferred because terminology changes can be 
managed through the data dictionary instead of a form-by-form vocabulary override basis. 
Once a translator overrides the item with a specific translation, jargon can no longer be 
applied. In the case that jargon does not exist, you should work with content developers or 
product experts to add new jargon terminology to the data dictionary so that the proper jargon 
translation can be applied during runtime processing. 

Important 

If you create an override for a translation item, that translation item is static and cannot be 
used dynamically anywhere else. You will have to maintain overrides individually. Therefore, 
you should use the data dictionary default values whenever possible.  
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Alpha Jargon 

When a new glossary entry, or F1 help, is applied to an item, the developer changes the 
alpha description because it is the title of the F1 help. In these instances, a developer would 
apply alpha jargon.  

Alpha jargon can apply to individual forms or entire systems. For instance, when a data 
dictionary item is used in the same context throughout an entire system, the developer would 
apply system-level alpha jargon. When an item is used in a different context in only one form, 
the developer would apply form-level alpha jargon. 

In the following example, the data item AN8 has both system-level jargon (identified by 12, 
15, 19, and so on in the Product Code Reporting column) and form-level jargon (identified by 
W03013B, W0401A, W0474N3B, and so on in the ScrnRpt Name column) applied.  

 

Row and Column Jargon 

Developers apply row and column jargon when they want a description other than the base 
description to appear on a form. Row and column jargon can apply only to entire systems.  

For example, the base description for the data dictionary item AN8 is Address Book Number. 
When the data item is used without any jargon, the system displays it as Address Number. 

However, when used in Product Code 42 (Sales Management), the item is more 
appropriately described as Sold To. 

The new description, Sold To, is a new data dictionary item. This new item appears as 
Product Code 00 with a Reporting Code of 42. In this instance, all forms in system 42 that 
contain the data dictionary item AN8 will display Sold To. 

When you translate row and column jargon, the DD translation tool updates the status of 
each form item in which the jargon data dictionary item is used to DD Default (status = 15). 
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When you begin translating forms, you must search for all items with a DD Default (status = 
15) and verify that the translation fits in the allotted space on the individual forms.  

Forms Design Aid (FDA) Overrides 

Overrides are similar to jargon except that they occur at the form level. The two types of FDA 
overrides are English and Translation.  

English Overrides 

J.D. Edwards forms can be reused in multiple systems. In these cases, developers apply 
English overrides to data dictionary items and enter alternate descriptions. Developers can 
apply English overrides to specific forms but not to entire systems.  

For example, when a form is called from system 30, a text field might be described as 
Customer Number. When called from system 31, the same text field might be described as 
Address Book Number. When you translate the forms in system 30, you will only see the 
description Customer Number.   

When an English override exists, the translation is automatically overridden.  

Note Concerning the FDA Translation Tool and English Overrides 

In the FDA Translation Tool, you can view the items that have overrides. Items that have 
overrides have a check mark in the Text Overridden check box. 

 

 

Language Overrides 

As a translator, you can enter a language override when the description of an item does not 
fit the context of the form. A translation override applies only to the item as it is used on a 
particular form. Although the following circumstances might require language overrides, use 
language overrides sparingly:  

• The data dictionary translation does not fit in the allotted space in a form. 

• The data dictionary translation is not appropriate for the context. 

 

 




